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About This Guide

This Novell ZENworks 10 Asset Inventory Reference includes information to help you successfully 
perform inventory tasks. The information in this guide is organized as follows:

 Chapter 1, “Overview,” on page 11

 Chapter 2, “Scanning Managed Devices,” on page 13

 Chapter 3, “Scanning Inventory Only Devices,” on page 33

 Chapter 4, “Scanning Demographic Data,” on page 45

 Chapter 5, “Importing Demographic Data,” on page 63

 Chapter 6, “Creating Local Software Products,” on page 71

 Chapter 7, “Using Administrator-Defined Fields,” on page 79

 Chapter 8, “Using Reports,” on page 83

 Chapter 9, “Managing Component Data,” on page 97

 Chapter 10, “Managing Product Data,” on page 101

 Appendix A, “Inventory Workflow,” on page 107

 Appendix B, “Troubleshooting Asset Inventory,” on page 109

 Appendix C, “Documentation Updates,” on page 113

Audience

This guide is intended for Novell ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.

Additional Documentation

ZENworks 10 Configuration Management with Asset Inventory is supported by other 
documentation (in both PDF and HTML formats) that you can use to learn about and implement the 
product. For additional documentation, see the ZENworks 10 Configuration Management 
documentation (http://www.novell.com/documentation/zam10/)

ZENworks 10 Asset Management with Asset Inventory is supported by other documentation (in 
both PDF and HTML formats) that you can use to learn about and implement the product. For 
additional documentation, see the ZENworks 10 Asset Management documentation (http://
www.novell.com/documentation/zam10/).
About This Guide 9
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1
1Overview

Novell ZENworks 10 Asset Inventory allows you to take an inventory of all the devices in your 
Management Zone, including data on hardware, software, and demographics.

The following sections contain additional information:

 Section 1.1, “Scanning for Hardware Information,” on page 11

 Section 1.2, “Scanning for Software Information,” on page 11

 Section 1.3, “Scanning for Demographic Information,” on page 11

 Section 1.4, “Security Considerations,” on page 11

1.1  Scanning for Hardware Information
Asset Inventory allows you to scan and collect hardware data for all the devices in your 
Management Zone. The hardware data includes information about keyboard, video adapter, bus 
adapter, monitor, CD/DVD, LAN adapter, diskette, hard drive, memory module, parallel port, 
printer, mouse, BIOS, serial port, system board, processor, USB keyboard and USB port. You might 
also find other categories of hardware components apart from the ones listed. The unrecognized 
hardware components are listed as Other Hardware in the inventory scan report. You can view the 
collected hardware data in several ways by using standard and custom reports. 

1.2  Scanning for Software Information
Asset Inventory allows you to scan all the devices in your Management Zone and collect data on 
what software products are installed on those devices. Asset Inventory can identify thousands of 
products and allows you to define additional products sothat they can be recognized on subsequent 
scans and on other devices. Data can be displayed through a variety of reports. This data can be used 
for general information, license compliance, and so on.

1.3  Scanning for Demographic Information
Asset Inventory allows you to collect demographic information by using one of the following:

 Collection Data Form: You can poll workstation users for demographic data, such as name, 
phone number, department, cost center, and so on. This information is added to the inventory 
data, giving you a complete picture of all the devices in your Management Zone.

 LDAP Import Tasks: You can import demographic data from Microsoft Active Directory and 
Novell eDirectory to the Novell ZENworks database. You can set up tasks for different Active 
Directory or e-Directory LDAP sources, and schedule each task individually. 

1.4  Security Considerations
No integrity protection is provided for inventory data because it is collected from agents. Because 
access to inventory data could provide information on how to attack a machine in the Management 
Zone, Asset Inventory should only be used in a secure environment. In addition, the database where 
the inventory data is stored should also be protected.
Overview 11
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To avoid security threats, Windows managed devices have restricted permissions when accessing 
network drives for the processes which run in System context. The ZENworks Adaptive Agent can 
detect Network drives only with administrator privilege access.
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2
2Scanning Managed Devices

An inventory scan of your managed devices provides you with a detailed report of each device’s 
hardware, software, and demographic data. The following sections provide information on inventory 
scans:

 Section 2.1, “Configuring an Inventory Scan,” on page 13

 Section 2.2, “Scheduling an Inventory Scan,” on page 17

 Section 2.3, “Running an Inventory Scan,” on page 26

 Section 2.4, “Viewing an Inventory Report for a Managed Device,” on page 28

 Section 2.5, “Editing a Managed Device’s Inventory Data,” on page 30

2.1  Configuring an Inventory Scan
An inventory scan allows you to collect data from managed devices in your Management Zone. By 
default, the inventory settings are preconfigured.

You can define the scan settings at three levels:

 Management Zone: The settings are inherited by all device folders and devices. To configure 
a scan for the management zone, see Section 2.1.1, “Configuring a Scan for the Management 
Zone,” on page 13.

 Device Folder: The settings are inherited by all devices contained within the folder or its 
subfolders. Overrides the Management Zone settings

 Device: The settings apply only to the device for which they are configured. Overrides the 
settings at the Management Zone level and the device folder level. To configure a scan for a 
device, see Section 2.1.3, “Configuring an Inventory Scan for a Device,” on page 17.

2.1.1  Configuring a Scan for the Management Zone

1 In ZENworks Control Center, click Configuration, then in the Management Zone Settings 
panel, click Inventory.

2 Click Inventory in the category list.

3 In the Scan Now panel, configure how to run an on-demand inventory scan by using a Quick 
Task, device task, or by using the ZENworks Icon menu. 

For more information on running an on-demand inventory scan, see Section 2.3, “Running an 
Inventory Scan,” on page 26.

Collect Software Applications: Select this option if you want to scan for software 
applications. This setting is selected by default.
Scanning Managed Devices 13
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Collect Software File Information: Select this option if you want to scan for software file 
information that can be used to identify software products that aren’t recognized by the 
ZENworks Knowledgebase. If you plan to create Local Software Products and add them to the 
knowledgebase, this option must be selected. For more information, see Chapter 6, “Creating 
Local Software Products,” on page 71.

Collect Hardware: Select this option if you want to scan for hardware data. This setting is 
selected by default.

Launch Collection Data Form: Select this option if you want to send out the Collection Data 
Form, which is used to collect demographic data. For more information, see Chapter 4, 
“Scanning Demographic Data,” on page 45.

Run DMTF Translator: Select this option if you want to run the DMTF (Desktop 
Management Task Force) Translator. The DMTF translator converts the inventory data to 
formats that can be used by other tools and puts it on the local machine.

User Can Initiate Scan: Select this option if you want to allow the workstation user to initiate 
a scan by using the ZENworks Icon.

4 In the First Scan panel, configure how you want to run an initial inventory scan on a device. 

Collect Software Applications: Select this option if you want to scan for software 
applications. This setting is selected by default.

Collect Software File Information: Select this option if you want to scan for software file 
information that can be used to identify software products that aren’t recognized by the 
ZENworks Knowledgebase. If you plan to create Local Software Products and add them to the 
knowledgebase, this option must be selected. For more information, see Chapter 6, “Creating 
Local Software Products,” on page 71.

Collect Hardware: Select this option if you want to scan for hardware data. This setting is 
selected by default.

Launch Collection Data Form: Select this option if you want to send out the Collection Data 
Form, which is used to collect demographic data, when a scan is initiated. For more 
information, see Chapter 4, “Scanning Demographic Data,” on page 45.

Run DMTF Translator: Select this option if you want to run the DMTF (Desktop 
Management Task Force) Translator. The DMTF translator converts the inventory data to 
formats that can be used by other tools and puts it on the local machine.

5 In the Recurring Scan panel, configure how you want to run scans based on a schedule.

Collect Software Applications: Select this option if you want to scan for software 
applications. This setting is selected by default.
orks 10 Asset Management Asset Inventory Reference



Collect Software File Information: Select this option if you want to scan for software file 
information that can be used to identify software products that aren’t recognized by the 
ZENworks Knowledgebase. If you plan to create Local Software Products and add them to the 
knowledgebase, this option must be selected. For more information, see Chapter 6, “Creating 
Local Software Products,” on page 71.

Collect Hardware: Select this option if you want to scan for hardware data. This setting is 
selected by default.

Launch Collection Data Form: Select this option if you want to send out the Collection Data 
Form, which is used to collect demographic data. For more information, see Chapter 4, 
“Scanning Demographic Data,” on page 45.

Run DMTF Translator: Select this option if you want to run the DMTF (Desktop 
Management Task Force) Translator. The DMTF translator converts the inventory data to 
formats that can be used by other tools and puts it on the local machine.

6 In the Software Applications panel, configure which directories to skip. 

Skipping directories is useful in limiting the scope of the scan. Any entry added to the list skips 
that directory and all the subdirectories below it.

 To add a directory, specify a directory in the Skip Directories field, then click Add.

 To edit an existing directory, select the directory, click Edit, edit the directory, then click 
OK.

 To delete an existing directory, select the directory, then click Remove.

7 In the Software Files panel, configure which types of files to scan for.
Scanning Managed Devices 15
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Software applications discovered in an inventory scan are identified by specific files associated 
with the product. These identifications are kept in the ZENworks Knowledgebase. To identify 
products that aren’t in the knowledgebase, you can search for files that are associated with an 
unrecognized product and use the file information to create a new product identification called 
a Local Software Product. This Local Software Product information can then be merged with 
the knowledgebase so that these new products are recognized in subsequent scans. For more 
information, see Chapter 6, “Creating Local Software Products,” on page 71. To configure the 
file types, do the following:

 To search for files with an .exe extension, select the Collect .EXE Files option.

 To search for files with a different extension, specify the extension in the Additional 
Extensions field. Separate each extension with a + sign, for example, com+dll.

 To scan for particular file types, select from the following:

 System: Select this option to search for system files. This category is selected by 
default.

 Ancillary Application: Select this option to search for files that are ancillary to, or 
associated with, a product that is recognized by the ZENworks Knowledgebase. This 
option is useful to create a comprehensive scan. This category is selected by default.

 Other: Select this option to search for all other files. This category is selected by 
default.

 To include directories with products that are recognized by the ZENworks 
Knowledgebase, select Include directories with recognized products. This is useful to 
create a comprehensive scan.

 To limit the scope of the scan by including and excluding files and paths, configure which 
files and paths to include or exclude from the collection by using Add and Remove to 
specify which files and paths you want to include and exclude from the scan. You can edit 
the files and paths in the list by selecting the file or path and clicking Edit. If you specify a 
file or path in the Files and paths to include in collection field, the scan is limited to just 
that file or path. If a file or path is specified in the Files and paths to exclude from 
collection field, all files and paths are searched except the specified file or path. Paths 
specified in the Software Applications panel are also skipped.

NOTE: If you are specifying a path, you must include a trailing backslash (\). For 
example, if you want to include all .exe files in the dir directory, type C:\dir\.

8 In the Advanced panel, configure diagnostic settings.

WARNING: These options are intended for advanced diagnostics. Use them only under the 
guidance of a Novell Support representative.

9 Click Apply or OK.
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2.1.2  Configuring a Scan for Devices in a Folder

1 In ZENworks Control Center, click the Devices tab, then click the Managed tab.

2 Click Details next to the folder containing the devices you want to configure a scan for.

3 Click the Settings tab.

4 In the Settings panel, click Inventory.

5 In the Catalog list, click Inventory.

6 In the Inventory panel, click Override settings.

This overrides the Management Zone settings for these devices.

7 In the Scan Now panel, configure how to run an inventory scan

For configuring an inventory scan, perform steps from Step 3 on page 13 through Step 9 on 
page 16 listed in Section 2.1, “Configuring an Inventory Scan,” on page 13.

2.1.3  Configuring an Inventory Scan for a Device

1 In ZENworks Control Center, click Devices, then click the Managed tab.

2 Click the folder containing the device you want to configure a scan for.

3 Click the device.

4 Click the Settings tab.

5 In the Settings panel, click Inventory.

6 In the Catalog list, click Inventory.

7 In the Inventory panel, click Override settings.

This overrides the Management Zone and folder settings for this device.

8 In the Scan Now panel, configure how to run an inventory scan

For configuring an inventory scan, perform steps from Step 3 on page 13 through Step 9 on 
page 16 listed in Section 2.1, “Configuring an Inventory Scan,” on page 13.

2.2  Scheduling an Inventory Scan
This section shows you how to schedule an inventory scan. By default, the inventory schedule is 
already configured.

You can define the scan schedule settings at three levels:

 Management Zone: The settings are inherited by all device folders and devices. To schedule a 
scan for the Management Zone, see Section 2.2.1, “Configuring an Inventory Scan Schedule 
for the Management Zone,” on page 18.

 Device Folder: The settings are inherited by all devices contained within the folder or its 
subfolders. Overrides the Management Zone settings. To schedule a scan for devices in a 
folder, see Section 2.2.2, “Configuring an Inventory Scan Schedule for Devices in a Folder,” on 
page 26.

 Device: The settings apply only to the device for which they are configured. Overrides the 
settings at the Management Zone level and device folder level. To schedule a scan for a device, 
see Section 2.2.3, “Configuring an Inventory Scan Schedule for a Device,” on page 26.
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2.2.1  Configuring an Inventory Scan Schedule for the 
Management Zone

1 In ZENworks Control Center, click Configuration, then in the Management Zone Settings 
panel, click Inventory.

2 Click Inventory Schedule in the category list.

3 In the Schedule Type field, select what type of schedule you want to use.

No Schedule: No scan is scheduled. See “No Schedule” on page 18.

Date Specific: Scans run on specified dates. See “Date Specific” on page 18.

Recurring: Scans run on a recurring schedule. See “Recurring” on page 19.

Event: Scans are triggered by an event. See “Event” on page 25.

No Schedule

1 Select No Schedule in the Schedule Type field.

2 Click Apply or OK.

No automatic scans are configured.

Date Specific

1 Select Date Specific in the Schedule Type field.
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2 Click the + icon to the right of the Start Date(s) field to open a calendar, then select a date. To 
select more than one date, click the + icon again. Click the - icon to delete a selected date.

3 (Optional) Select Run event every year to run a scan annually on the dates you selected.

4 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger 
the event immediately, select Process immediately if device unable to execute on schedule. 

5 Select whether you want the scan to start at a specified time or at a random time between a 
specified start and end time.

6 Specify a start time, and if you selected Start at a random time between Start Time and End 
Time, specify an end time.

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management 
zone is across geographical locations. 

8 Click Apply or OK.

Recurring

Select whether you want the scan to run when a device is refreshed, on certain days of the week, 
monthly, or at a fixed interval.

To run a scan when a device is refreshed:

1 Select Recurring in the Schedule Type field.

2 Select When a device is refreshed.
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3 (Optional) If you want the scan to be delayed for a set time after a refresh, select Delay 
execution after refresh and specify the time in days, hours, and minutes.

4 Click Apply or OK.

To run a scan on certain days of the week:

1 Select Recurring in the Schedule Type field.

2 Select Days of the week.

3 Select the days on which you want the scan to run.

4 In the Start Time field, specify the time you want the scan to start.
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5 Click More Options.

6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger 
the event immediately, select Process immediately if device unable to execute on schedule. 

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management 
zone is across geographical locations. 

8 (Optional) If you want the scan to start randomly between a specified start and end time, select 
Start at a random time between Start Time and End Time, then specify an end time.

9 (Optional) If you want to restrict the scan to a certain date range, select Restrict schedule 
execution to the following date range, then specify the start and end dates.

10 Click Apply or OK.

To run a scan monthly:

1 Select Recurring in the Schedule Type field.
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2 Select Monthly.

3 Select either Day of the month and specify a number between 1 and 31, Last day of the month, 
or select the configurable field where you can choose a combination of days of the month for a 
recurring scan.

4 In the Start Time field, specify the time you want the scan to start.

5 Click More Options.
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6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger 
the event immediately, select Process immediately if device unable to execute on schedule. 

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management 
zone is across geographical locations. 

8 (Optional) If you want the scan to start randomly between a specified start and end time, select 
Start at a random time between Start Time and End Time, then specify an end time.

9 (Optional) If you want to restrict the scan to a certain date range, select Restrict schedule 
execution to the following date range, then specify the start and end dates.

10 Click Apply or OK.

To run a scan at a fixed interval:

1 Select Recurring in the Schedule Type field.
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2 Select Fixed Interval.

3 Specify the number of months, weeks, days, hours, and minutes in their respective fields.

NOTE: 

 If a Satellite with Collection role is configured in the Management Zone, ensure that the scan 
interval is set such that the scan schedule is less frequent than the Collection Roll-Up 
Schedule.

Currently, When a device is refreshed Schedule Type is not effective for Inventory Scans.

4 Specify a start date by clicking the calendar icon and selecting a date.

5 In the Start Time field, specify the time you want the scan to start.

6 Click More Options.
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7 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger 
the event immediately, select Process immediately if device unable to execute on schedule. 

8 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management 
zone is across geographical locations.

9 (Optional) If you want to restrict the scan to a certain date range, select Restrict schedule 
execution to the following date range, then specify an end date and end time.

10 Click Apply or OK.

Event

1 Select Event in the Schedule Type field.

NOTE: Currently Event Schedule Type is not supported. Event based schedules are not 
effective for Inventory Scans on managed devices. 

2 Select an event.

 User login

 User logout

 Device boot

 Device shutdown

 On device lock

 On device unlock

 ZENworks - Login

 ZENworks - Logout

 Device connecting to network (Windows only)
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3 Click Apply or OK.

A scan is made following the selected event.

2.2.2  Configuring an Inventory Scan Schedule for Devices in a 
Folder

1 In ZENworks Control Center, click Devices, then click the Managed tab.

2 Click Details next to the folder containing the devices you want to configure an inventory scan 
schedule for.

3 Click the Settings tab.

4 In the Settings panel, click Inventory.

5 In the Settings list, click Inventory Schedule.

6 In the Inventory Schedule panel, click Override settings.

This overrides the Management Zone settings for these devices.

7 In the Schedule Type field, configure the schedule you want to use.

For configuring the schedule type, perform steps from Step 3 on page 18 through Step 8 on 
page 17 listed in Section 2.2.1, “Configuring an Inventory Scan Schedule for the Management 
Zone,” on page 18.

2.2.3  Configuring an Inventory Scan Schedule for a Device

1 In ZENworks Control Center, click Devices, then click the Managed tab.

2 Click the folder containing the device you want to configure an inventory scan schedule for.

3 Click the device.

4 Click the Settings tab.

5 In the Settings panel, click Inventory.

6 In the Settings list, click Inventory Schedule.

7 In the Inventory Schedule panel, click Override settings.

This overrides the Management Zone and folder settings for this device.

8 In the Schedule Type field, configure the schedule you want to use.

For configuring the schedule type, perform steps from Step 3 on page 18 through Step 8 on 
page 17 listed in Section 2.2.1, “Configuring an Inventory Scan Schedule for the Management 
Zone,” on page 18.

2.3  Running an Inventory Scan
You can run a scan four different ways:

 Using a device Quick Task

 Using a device task

 Using the ZENworks Icon menu (this runs a scan of the local machine only)

 Using a schedule
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To run an inventory scan using a Quick Task:

1 In ZENworks Control Center, click Devices, then click the Managed tab.

2 Click the folder with the desired device(s) and select one or more devices that you want to 
inventory.

3 Click Quick Tasks > Inventory Scan.

A Quick Task Status dialog box appears, showing the progress of the scan.

To run an inventory scan using a device task:

1 In ZENworks Control Center, click Devices, then click the Managed tab.

2 Open the folder with the desired device and click the device.

3 In the device tasks panel, click Server Inventory Scan if it’s a server; click Workstation 
Inventory Scan if it’s a workstation.

To run an inventory scan using the ZENWorks Icon menu:

NOTE: This feature is only available if the User Can Initiate Scan option is selected on the 
Inventory configuration page. For more information, see Section 2.1, “Configuring an Inventory 
Scan,” on page 13.

1 Right-click the ZENworks Icon and select Show Properties.

2 Click Inventory.
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3 Click Scan Now.

4 (Optional) Click Refresh Page to update scan times.

To run an inventory scan by using a schedule, see Section 2.2, “Scheduling an Inventory Scan,” on 
page 17.

2.4  Viewing an Inventory Report for a Managed 
Device
A device’s inventory includes information on hardware, software, and demographic data, which is 
gathered in an inventory scan. You can view this report through ZENworks Control Center or by 
using the ZENworks Icon menu. 

To view a managed device’s inventory using ZENworks Control Center:

1 In ZENworks Control Center, click Devices.

2 Click the Managed tab.

3 Click the folder containing the device you want to view the inventory for.

4 Click the desired device.

5 Click the Inventory tab.

The Summary panel shows basic inventory information.
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6 Click Detailed Hardware/Software Inventory for a complete inventory report.

This report shows detailed information about the device, including demographic data, hardware 
information, and software. From this page, you can click the various links to get more detailed 
information. You can export the report to Excel, CSV, or PDF formats. You can also edit 
selected data. For more information, see Section 2.5, “Editing a Managed Device’s Inventory 
Data,” on page 30. 

To view a managed device’s inventory using the ZENworks Icon menu:

1 Right-click the ZENworks icon and select Show Properties.

2 Click Inventory.
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3 Click View Inventory Details.

2.5  Editing a Managed Device’s Inventory Data
1 Open the Detailed Hardware/Software Inventory report as shown in Section 2.4, “Viewing an 

Inventory Report for a Managed Device,” on page 28.

2 Click Edit.
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3 Add or edit information on the Edit Workstation page.

User: Basic information about the user, including name, phone, and so on.

Reference: Inventory type, serial number, and asset tag. These values cannot be changed.

Workstation: Basic information about the workstation, including site, department, and so on. 
Click the icon on the right to create a list of responses. Click the calendar icon next to the Lease 
Expiration Date field to choose a date.

4 Click Submit.

The data is added to the inventory report.
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3
3Scanning Inventory Only Devices

An inventory only scan allows you to scan devices in the zone that don’t have the ZENworks 
Adaptive Agent installed but do have the Inventory Only Module installed. For information on 
installing the Inventory Only Module, see the ZENworks 1 Discovery, Deployment, and Retirement 
Reference. 

The following sections provide information on inventory only scans:

 Section 3.1, “Configuring an Inventory Only Scan,” on page 33

 Section 3.2, “Scheduling an Inventory Only Scan,” on page 36

 Section 3.3, “Viewing an Inventory Report for an Inventory Only Device,” on page 40

 Section 3.4, “Editing the Demographic Data of an Inventory Only Device,” on page 40

 Section 3.5, “Enabling Reconciliation,” on page 41

 Section 3.6, “Using the Portable Collector,” on page 42

3.1  Configuring an Inventory Only Scan
An inventory only scan allows you to collect data from devices in the Management Zone that only 
have the Inventory Only Module installed. By default, the inventory settings are preconfigured.

To configure an inventory only scan:

1 Click Configuration, then in the Management Zone Settings panel, click Inventory.

2 Click Inventory Only in the category list.

3 In the Server Refresh Interval panel, set the interval time in days, hours, and minutes. 

The server handles requests from devices that have the Inventory Only Module installed, 
providing files for the settings, scan schedule, and so on. The interval setting determines how 
often the server evaluates the next scan schedule and when to obtain other settings. The server 
needs to poll the database at frequent intervals to pass on any changes that affect the devices.

The refresh interval should be set so that refreshes occur more frequently than scans. The 
default is 15 minutes.

NOTE: Ensure that the time interval of the Collection Server sending over data to the Primary 
server is lesser than the time interval of the managed devices sending over data to the 
Collection Server. For example, if Managed device M1 sends data to Collection Server every 
12 minutes, configure the Collection Server to send data to the Primary server every 8 minutes. 

4 In the Device Refresh Interval panel, set the interval time in days, hours, and minutes. 
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The Device Refresh Interval determines when the device checks the server for a change in 
settings, the schedule for the next scan, the ZENworks Knowledgebase for inventory, and new 
agent executables. 

The refresh interval should be set so that refreshes occur more frequently than scans and less 
frequently than server refreshes. The default is 12 hours.

5 In the Scan panel, configure how you want to run the scan.

Collect Software Applications: Select this option if you want to scan for software 
applications installed on the device. This setting is selected by default.

Collect Software File Information: Select this option if you want to scan for software file 
information that can be used to identify software products that are not recognized by the 
ZENworks Knowledgebase. If you plan to create Local Software Products and add them to the 
knowledgebase, this option must be selected. For more information, see Chapter 6, “Creating 
Local Software Products,” on page 71.

Collect Demographic Data: Select this option to gather demographic data from an 
inventoried-only device. This data is gathered from a file on the local machine. For more 
information, see Section 4.6, “Scanning Demographic Data on an Inventory Only Device,” on 
page 60.

Run DMTF Translator: Select this option if you want to run the DMTF (Desktop 
Management Task Force) Translator. The DMTF translator converts the inventory data to 
formats that can be used by other tools and puts it on the local machine.

6 In the Software Applications panel, configure which directories to skip. 

Skipping directories is useful in limiting the scope of the scan. The directories in the list are 
skipped.

 To add a directory, specify a directory in the Skip Directories field, then click Add.
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 To edit an existing directory, select the directory, click Edit, edit the directory, then click 
OK.

 To delete an existing directory, select the directory and click Remove.

7 In the Software Files panel, configure which types of files to scan for.

Software applications discovered in an inventory scan are identified by specific files associated 
with the product. These identifications are kept in the ZENworks Knowledgebase. To identify 
products that aren’t in the knowledgebase, you can search for files that are associated with an 
unrecognized product and use the file information to create a new product identification called 
a Local Software Product. This Local Software Product information can then be merged with 
the knowledgebase so that these new products are recognized in subsequent scans. For more 
information, see Chapter 6, “Creating Local Software Products,” on page 71. To configure the 
file types, do the following:

 To search for files with an .exe extension, select the Collect .EXE Files option.

 To search for files with a different extension, specify the extension in the Additional 
Extensions field. Separate each extension with a + sign, for example, com+dll.

 To scan for particular file types, select from the following:

 System: Select this option to search for system files. This category is selected by 
default.

 Ancillary Application: Select this option to search for files that are ancillary to, or 
associated with, a product that is recognized by the ZENworks Knowledgebase. This 
option is useful to create a comprehensive scan. This category is selected by default.

 Other: Select this option to search for all other files. This category is selected by 
default.

 To include directories with products that are recognized by the ZENworks 
Knowledgebase, select Include directories with recognized products. This is useful to 
create a comprehensive scan.

 To limit the scope of the scan by including and excluding files and paths, configure which 
files and paths to include or exclude from the collection by using Add and Remove to 
specify which files and paths you want to include and exclude from the scan. You can edit 
the files and paths in the list by selecting the file or path and clicking Edit. If you specify a 
file or path in the Files and paths to include in collection field, the scan is limited to just 
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that file or path. If a file or path is specified in the Files and paths to exclude from 
collection field, all files and paths are searched except the specified file or path. Paths 
specified in the Software Applications panel are also skipped.

NOTE: If you are specifying a path, you must include a trailing backslash (\). For 
example, if you want to include all .exe files in the dir directory, type C:\dir\.

8 In the Advanced panel, configure diagnostic settings.

WARNING: These options are intended for advanced diagnostics. Use them only under the 
guidance of a Novell Support representative.

9 In the Collection Servers panel, use the Move Up and Move Down buttons to arrange the 
collection servers.

This arrangement determines the order in which the collection servers receive the inventory 
data.

10 Click Apply or OK.

3.2  Scheduling an Inventory Only Scan
This section shows you how to schedule an inventory scan for an inventory only device. By default, 
the inventory schedule is already configured.

Unlike scans for managed devices, you can only define an inventory only scan for the entire 
Management Zone. In addition, you can run a scan only by using a schedule.

3.2.1  To Configure an Inventory Only Scan Schedule

1 In ZENworks Control Center, click Configuration, then in the Management Zone Settings 
panel, click Inventory.

2 Click Inventory Only Schedule in the category list.

3 In the Schedule Type field, select what type of schedule you want to use.

No Schedule: No scan is scheduled. See “No Schedule” on page 37.

Date Specific: Scans run on specified dates. See “Date Specific” on page 37.

Recurring: Scans run on a recurring schedule. See “Recurring” on page 37.
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No Schedule

1 Select No Schedule in the Schedule Type field.

2 Click Apply or OK.

No automatic scans are configured.

Date Specific

1 Select Date Specific in the Schedule Type field.

2 Click the + icon to the right of the Start Date(s) field to open a calendar, then select a date. To 
select more than one date, click the + icon again. Click the - icon to delete a selected date.

3 Specify a start time.

4 Click Apply or OK.

Recurring

Select whether you want the scan to run when a device is refreshed, on certain days of the week, 
monthly, or at a fixed interval.

To run a scan on certain days of the week:

1 Select Recurring in the Schedule Type field.
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2 Select Days of the week.

3 Select the days on which you want the scan to run.

4 In the Start Time field, specify the time you want the scan to start.

5 Click Apply or OK.

To run a scan monthly:

1 Select Recurring in the Schedule Type field.
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2 Select Monthly.

3 Select either Day of the month and specify a number between 1 and 31, Last day of the month, 
or select the configurable field where you can choose a combination of days of the month for a 
recurring scan.

4 In the Start Time field, specify the time you want the scan to start.

5 Click Apply or OK.

To run a scan at a fixed interval:

1 Select Recurring in the Schedule Type field.

2 Select Fixed Interval.

3 Specify the number of months, weeks, days, hours, and minutes in their respective fields.

4 Specify a start date by clicking the calendar icon and selecting a date.

5 In the Start Time field, specify the time you want the scan to start.

6 Click Apply or OK.
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NOTE: Ensure that the Collection Roll-Up Schedule is more frequent than the scan interval if 
the Satellite with Collection role is configured in the Management Zone.

3.3  Viewing an Inventory Report for an Inventory 
Only Device
A device’s inventory includes information on hardware, software, and demographic data, which is 
gathered in an inventory scan. 

To view an inventoried-only device’s inventory:

1 In ZENworks Control Center, click Devices.

2 Click the Inventoried tab.

3 Click the folder containing the device you want to view the inventory of.

4 Click the desired device.

The Inventory panel shows basic inventory information.

5 Click Detailed Hardware/Software Inventory for a complete inventory report.

This report shows detailed information about the device, including demographic data, hardware 
information, and software. From this page, you can click the various links to get more detailed 
information. You can export the report to Excel, CSV, or PDF formats. You can also edit 
demographic data. For more information, see Section 2.5, “Editing a Managed Device’s 
Inventory Data,” on page 30. 

3.4  Editing the Demographic Data of an 
Inventory Only Device
To add or edit demographic data in a report:

1 Open the Detailed Hardware/Software Inventory report as shown in Section 2.4, “Viewing an 
Inventory Report for a Managed Device,” on page 28.

2 Click Edit.
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3 Add or edit information on the Edit Workstation page.

User: Basic information about the user, including name, phone, and so on.

Reference: Inventory type, serial number, and asset tag. These values cannot be changed.

Workstation: Basic information about the workstation, including site, department, and so on. 
Click the icon on the right to create a list of responses. Click the calendar icon next to the Lease 
Expiration Date field to choose a date.

4 Click Submit.

The data is added to the inventory report.

3.5  Enabling Reconciliation
Inventory Only Reconciliation allows you to control whether and how new workstations are 
reconciled to avoid the possibility of duplicates in the database. When a scan is made of a 
workstation that is new to the Management Zone, it is assigned an identifier. If the identifier is lost, 
such as by a disk crash, it is assigned a new identifier during the next scan. Reconciliation allows 
you to check whether the workstation is already in the database. If it is, the identifier in the database 
is changed to match the new identifier.

You can use any or all of the following device attributes to identify a workstation for possible 
reconciliation:

 Serial Number

 MAC Address

 Machine Name

To enable inventory only reconciliation:

1 In ZENworks Control Center, click the Configuration tab.

2 In the Management Zone Settings panel, click Inventory.

3 In the Category list, click Inventory Only Reconciliation.
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4 In the Auto-Reconcile Settings panel, select which device attributes you want to use for 
reconciliation.

 Serial Number

 Mac Address

 Machine Name

5 Select Enable Differentiation to differentiate between workstations with the same identifier.

6 Click Apply or OK.

3.6  Using the Portable Collector
The Portable Collector is a standalone application that is used to inventory devices that rarely 
connect to the server or devices that do not have the ZENworks Adaptive Agent installed. This data 
can then be imported into the Inventoried device list. When the data is imported, you can view and 
edit it just as you would an inventoried device. The Portable Collector can be run on Windows and 
OSX devices. The procedure is as follows:

1. Create the Portable Collector.

2. Run the Portable Collector on a device.

3. Copy the inventory data to a portable media.

4. Upload the inventory data into ZENworks Control Center.

For more information, see the following:

 Section 3.6.1, “Creating the Portable Collector for a Windows Device,” on page 42

 Section 3.6.2, “Running the Portable Collector on a Windows Device,” on page 43

 Section 3.6.3, “Running the Portable Collector on an OSX Device,” on page 43

 Section 3.6.4, “Importing Data Gathered with the Portable Collector,” on page 44

3.6.1  Creating the Portable Collector for a Windows Device

1 Configure an Inventory Only scan.
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The Inventory Only scan settings are used when you create the Portable Collector. If you want 
the Portable Collector to scan for software files, for example, that option must be selected on 
the Inventory Only configuration page. For information on configuring an Inventory Only scan, 
see Section 3.1, “Configuring an Inventory Only Scan,” on page 33.

2 Click Devices.

3 In the Device Tasks list, click Create Portable Client.

4 Save the file to disk.

5 Uncompress the file and continue with Section 3.6.2, “Running the Portable Collector on a 
Windows Device,” on page 43.

3.6.2  Running the Portable Collector on a Windows Device

1 Create the Portable Collector as shown in Section 3.6.1, “Creating the Portable Collector for a 
Windows Device,” on page 42. 

2 Copy the Portable Collector files to a removable media, such as a CD or flash drive.

3 Take the Portable Collector to the device you want to inventory, then run collect.bat. 

To see the available switches, type /? on the command line.

4 Copy the inventory data files onto a removable media, then take it to a device connected to 
ZENworks Control Center.

5 Continue with Section 3.6.4, “Importing Data Gathered with the Portable Collector,” on 
page 44.

3.6.3  Running the Portable Collector on an OSX Device 

1 Navigate to https://ZENworks_Server_ID/zenworks-setup/ (where ZENworks_Server_ID is the 
DNS name or IP address of a Primary Server).

2 Click Inventory Tools.

3 Click osxportable.dmg to download it to the desktop.

4 Uncompress osxportable.dmg.

5 Create a temporary folder to run the portable scan from.

6 Copy the contents of osxportable, which is found in /Volumes/osxportable, to the 
temporary folder.

7 Close (eject) the osxportable image.

8 Open a terminal window.

You must be a user with administrative privileges.

9 Run sudo ./zenumia-portable /full/path/to/output/directory.

The WIF file (<xxx>.xml) will be written there. This file contains the device’s inventory data. It 
will be convenient for the output directory to be accessible by a Windows device. Or you can 
copy the file and put it on a device connected to the ZENworks Control Center.

10 When the scan finishes, remove the temporary directory you created in Step 5 and the file 
osxportable.dmg that you downloaded in Step 3.
Scanning Inventory Only Devices 43



44 ZENw
11 Import the file into ZENworks Control Center as shown in Section 3.6.4, “Importing Data 
Gathered with the Portable Collector,” on page 44.

12 Remove the inventory data file.

3.6.4  Importing Data Gathered with the Portable Collector

1 In ZENworks Control Center, click Devices.

2 In the Device Tasks list, click Import Inventory.

3 In the File Path for inventory scan file field, specify the filename of the inventoried data, or 
click Browse to search.

4 Click OK.

The inventoried device appears in the device lists in Devices > Inventoried, where you can 
click the device name and see the inventory data.
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4Scanning Demographic Data

Inventory scans include demographic data that is gathered from workstation users through the use of 
the Collection Data Form. The Collection Data Form can be sent to a workstation user’s computer 
with a prompt to fill out the data fields on the form. This data is then added to the inventory report 
for that workstation. This section includes the following topics:

 Section 4.1, “Configuring the Collection Data Form,” on page 45

 Section 4.2, “Deploying the Collection Data Form,” on page 49

 Section 4.3, “Scheduling the Deployment of the Collection Data Form,” on page 50

 Section 4.4, “Deploying the Data Collection Form Using a Quick Task,” on page 58

 Section 4.5, “Deploying the Data Collection Form Using a Device Task,” on page 59

 Section 4.6, “Scanning Demographic Data on an Inventory Only Device,” on page 60

4.1  Configuring the Collection Data Form
When you configure the Collection Data Form, you are selecting what information you want to 
gather from the workstation user. The Collection Data Form is not configured by default. It must be 
configured before it can be deployed.

You can define the Collection Data Form at three levels:

 Management Zone: The settings are inherited by all device folders and devices. To configure 
the Collection Data Form for the Management Zone, see Section 4.1.1, “Configuring the 
Collection Data Form for the Management Zone,” on page 46.

 Device Folder: The settings are inherited by all devices in the folder. Overrides the settings at 
the Management Zone level. To configure the Collection Data Form for a folder, see 
Section 4.1.2, “Configuring the Collection Data Form for Devices in a Folder,” on page 47.

 Device: The settings apply only to the device for which they are configured. Overrides the 
settings at the folder and Management Zone levels. To configure the Collection Data Form at 
the device level, see Section 4.1.3, “Configuring the Collection Data Form for a Device,” on 
page 48.

NOTE: If you are configuring the Collection Data Form settings on a device, you need to click 
Override Settings before you can change the system settings.

After it is configured and deployed, the Collection Data Form appears on the foreground or topmost 
windows on the desktop of a managed device and prompts the workstation user to respond to a list 
of predefined questions. If you want to launch the Collection Data Form in the background, you 
must create the HKLM\SOFTWARE\Novell\ZCM\INV_CDF registry key. 

For more information, see the following topics:

 Section 4.1.1, “Configuring the Collection Data Form for the Management Zone,” on page 46

 Section 4.1.2, “Configuring the Collection Data Form for Devices in a Folder,” on page 47

 Section 4.1.3, “Configuring the Collection Data Form for a Device,” on page 48
Scanning Demographic Data 45



46 ZENw
4.1.1  Configuring the Collection Data Form for the 
Management Zone

1 In ZENworks Control Center, click Configuration.

2 In the Management Zone Settings panel, click Inventory.

3 In the Category list, click Collection Data Form.

4 Specify any explanatory text for the workstation user in the Introductory Text field.

5 (Optional) If you want the Collection Data Form to be available to the workstation user to run 
at anytime, select Show in ZENworks Icon Menu.

This allows the workstation user to open the form by using the ZENworks Icon, and edit it as 
desired.

6 (Optional) Select Show Cancel button on form if you want to allow the workstation user to opt 
out of the process.

7 (Optional) Select Invisible mode for autofill only to populate the form with the autofill data. 
The form is hidden from the workstation user.

8 Select the data you want to gather, and configure how the workstation user can respond: 

Label: Displays the name of the data you’re collecting, such as First Name.

Data Type: Specifies the data type: character, integer, decimal, or date.

Display: Displays the specified field on the Collection Data Form that is sent to the 
workstation user.

Editable: Enables the user to enter or edit a response in the specified field rather than being 
forced to accept the default value.
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Required: Makes the response required. If a field is required, workstation users cannot submit 
the form until they enter the required data.

Autofill: Shows whether Autofill is on or off. Click No (or Yes, as appropriate) to open the 
Autofill dialog box, where you can specify a registry key or environment variable to populate 
the Collection Data Form field with the data that the registry key or variable points to, such as 
HKLM\SYSTEM\CurrentControlSet\Services\Eventlog\ComputerName for this registry 
key, or WinDir for this environment variable.

Default: Specify any value you want to use as a default value.

Choice List: If there is more than one possible response, click Edit and specify the available 
responses. You can also choose to allow the workstation user to create entries by selecting 
Allow user created entries.

Edit Mask: Allows you to restrict how a user enters a response by selecting a format from the 
list in the Edit Mask field. The choices are phone, time, and currency.

Instructions: Add any instructions for the workstation user.

9 Click Apply or OK, or click Reset to revert to previous settings.

NOTE: You can also create custom fields, called administrator-defined fields, to gather additional 
data. For more information, see Chapter 7, “Using Administrator-Defined Fields,” on page 79.

4.1.2  Configuring the Collection Data Form for Devices in a 
Folder

1 In ZENworks Control Center, click Devices.

2 In the Devices panel, click Details next to the folder whose devices you want to configure.

3 Click the Settings tab.

4 In the Settings panel, click Inventory.

5 In the Category panel, click Collection Data Form.
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6 Click Override settings.

This overrides the Management Zone settings for these devices.

7 In the Introductory Text field, specify information to configure the Collection Data Form.

For configuring the Collection Data Form, perform steps from Step 4 on page 46 through 
Step 9 on page 47 listed in Section 4.1.1, “Configuring the Collection Data Form for the 
Management Zone,” on page 46.

NOTE: You can also create custom fields, called administrator-defined fields, to gather additional 
data. For more information, see Chapter 7, “Using Administrator-Defined Fields,” on page 79.

4.1.3  Configuring the Collection Data Form for a Device

1 In ZENworks Control Center, click Devices.

2 Click the Managed tab. 

3 Click the folder that contains the device you want to configure.

4 Click the device.

5 Click the Settings tab.

6 In the Settings panel, click Inventory.

7 In the Catalog panel, click Collection Data Form.
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8 Click Override settings.

This overrides the Management Zone and folder settings for this device.

9 In the Introductory Text field, specify information to configure the Collection Data Form.

For configuring the Collection Data Form, perform steps from Step 4 on page 46 through 
Step 9 on page 47 listed in Section 4.1.1, “Configuring the Collection Data Form for the 
Management Zone,” on page 46.

NOTE: You can also create custom fields, called administrator-defined fields, to gather additional 
data. For more information, see Chapter 7, “Using Administrator-Defined Fields,” on page 79.

4.2  Deploying the Collection Data Form
There are four ways you can deploy the Collection Data Form to a workstation:

 Collection Data Form Schedule: Using the Collection Data Form schedule deploys the form 
to all the workstations in the Management Zone. For more information, see Section 4.3, 
“Scheduling the Deployment of the Collection Data Form,” on page 50. 

 Device Quick Task: Using a device Quick Task deploys the Data Collection Form to one or 
more workstation in a folder. For more information, see Section 4.4, “Deploying the Data 
Collection Form Using a Quick Task,” on page 58.

 Device Task: Using a device task deploys the Data Collection Form to a specified workstation. 
For more information, see Section 4.5, “Deploying the Data Collection Form Using a Device 
Task,” on page 59.

 Scheduled as part of an inventory scan: Using the inventory scan schedule deploys the 
Collection Data Form to all the workstations in the Management Zone. For more information, 
see Section 2.1, “Configuring an Inventory Scan,” on page 13. 
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4.3  Scheduling the Deployment of the Collection 
Data Form 

NOTE: If you selected Show in ZEN Icon Menu on the Collection Data Form configuration page, 
the Collection Data Form is always available to the workstation user to run at anytime. For more 
information, see Section 4.1, “Configuring the Collection Data Form,” on page 45.

You can define the schedule at three levels:

 Management Zone: The settings are inherited by all device folders and devices. To schedule 
the deployment of the Data Collection Form for the Management Zone, see Section 4.3.1, 
“Scheduling the Deployment of the Collection Data Form for the Management Zone,” on 
page 50.

 Device Folder: The settings are inherited by all devices in the folder. Overrides the settings at 
the Management Zone level. To schedule the deployment of the Data Collection Form for a 
device folder, see Section 4.3.2, “Scheduling the Deployment of the Collection Data Form for 
Devices in a Folder,” on page 57.

 Device: The settings apply only to the device for which they are configured. Overrides the 
settings at the Management Zone level. To schedule the deployment of the Data Collection 
Form for a device, see Section 4.3.3, “Scheduling the Deployment of the Collection Data Form 
for a Device,” on page 58.

4.3.1  Scheduling the Deployment of the Collection Data Form 
for the Management Zone

1 In ZENworks Control Center, click Configuration.

2 In the Management Zone Settings panel, click Inventory > Collection Data Form Schedule.

3 In the Schedule Type field, select the type of schedule you want to use to send out the 
Collection Data Form. You can select from the following options:

No Schedule: No deployment is scheduled. See “No Schedule” on page 50.

Date Specific: The Collection Data Form is deployed on specified dates. See “Date Specific” 
on page 51.

Recurring: The Collection Data Form is deployed on a recurring schedule. See “Recurring” on 
page 51.

Event: Deployment is triggered by an event. See “Event” on page 57.

No Schedule

1 Select No Schedule in the Schedule Type field.

2 Click Apply or OK.

The Collection Data Form is not scheduled to deploy.
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Date Specific

To deploy the Collection Data Form on a specified date: 

1 Select Date Specific in the Schedule Type field.

2 Click the + icon to the right of the Start Date(s) field to open a calendar, then select a date. To 
select more than one date, click the + icon again. Click the - icon to delete a selected date.

3 (Optional) Select Run event every year to deploy the Collection Data Form annually on the 
dates you selected.

4 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger 
the event immediately, select Process immediately if device unable to execute on schedule. 

5 Select whether you want to deploy the Collection Data Form at a specified time or at a random 
time between specified start and end times.

6 Specify a start time, and if you selected Start at a random time between Start Time and End 
Time, specify an end time.

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management 
zone is across geographical locations.

8 Click Apply or OK.

Recurring

Select whether you want to deploy the Collection Data Form when a device is refreshed, on certain 
days of the week, monthly, or at a fixed interval.

To deploy the Collection Data Form when a device is refreshed:

1 Select Recurring in the Schedule Type field.
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2 Select When a device is refreshed.

3 (Optional) If you want to delay deploying the Collection Data Form for a set time after a 
refresh, select Delay execution after refresh and specify the time in days, hours, and minutes.

4 Click Apply or OK.

To deploy the Collection Data Form on certain days of the week:

1 Select Recurring in the Schedule Type field.
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2 Select Days of the week.

3 Select the days on which you want to deploy the Collection Data Form.

4 In the Start Time field, specify the time you want to deploy the Collection Data Form.

5 Click More Options.
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6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger 
the event immediately, select Process immediately if device unable to execute on schedule. 

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management 
zone is across geographical locations. 

8 (Optional) If you want to deploy the Collection Data Form at a random time between a 
specified start and end time, select Start at a random time between Start Time and End Time, 
then specify an end time.

9 (Optional) If you want to restrict the deployment of the Collection Data Form to a certain date 
range, select Restrict schedule execution to the following date range, then specify the start and 
end dates.

10 Click Apply or OK.

To deploy the Collection Data Form monthly:

1 Select Recurring in the Schedule Type field.

2 Select Monthly.
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3 Select either Day of the month and specify a number between 1 and 31, Last day of the month, 
or select the configurable field where you can choose a combination of days of the month for a 
recurring schedule.

4 In the Start Time field, specify the time you want to deploy the Collection Data Form.

5 Click More Options.

6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger 
the event immediately, select Process immediately if device unable to execute on schedule. 

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management 
zone is across geographical locations. 

8 (Optional) If you want to deploy the Collection Data Form at a random time between a start and 
end time, select Start at a random time between Start Time and End Time, then specify an end 
time.

9 (Optional) If you want to restrict the deployment of the Collection Data Form to a certain date 
range, select Restrict schedule execution to the following date range, then specify the start and 
end dates.

10 Click Apply or OK.

To send out the Collection Data Form at a fixed interval:

1 Select Recurring in the Schedule Type field.
Scanning Demographic Data 55



56 ZENw
2 Select Fixed Interval.

3 Specify the number of months, weeks, days, hours, and minutes in their respective fields.

4 Specify a start date and time.

5 Click More Options.
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6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger 
the event immediately, select Process immediately if device unable to execute on schedule. 

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management 
zone is across geographical locations. 

8 (Optional) If you want to restrict the deployment of the Collection Data Form to a certain date 
range, select Restrict schedule execution to the following date range, then specify an end date 
and end time. 

9 Click Apply or OK.

Event

1 Select Event in the Schedule Type field.

2 Select one of the following:

 User login

 User logout

 Device boot

 Device shutdown

 On device lock

 On device unlock

 ZENworks Reauthorization - Login

 ZENworks Reauthorization - Logout

 Device connecting to network (Windows only)

3 Click Apply or OK.

4.3.2  Scheduling the Deployment of the Collection Data Form 
for Devices in a Folder

1 In ZENworks Control Center, click Devices.

2 Click Details next to the folder whose devices you want to configure.

3 Click the Settings tab.

4 In the Settings panel, click Inventory > Collection Data Form Schedule.

5 Click Override settings.
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This overrides the Management Zone settings.

6 In the Schedule Type field, configure the schedule you want to use.

For configuring the schedule type, perform steps from Step 3 on page 50 through Step 3 on 
page 57 listed in Section 4.3.1, “Scheduling the Deployment of the Collection Data Form for 
the Management Zone,” on page 50.

4.3.3  Scheduling the Deployment of the Collection Data Form 
for a Device

1 In ZENworks Control Center, click Devices, then click the Managed tab.

2 Click the folder containing the device you want to configure a schedule for.

3 Click the device.

4 Click the Settings tab.

5 In the Settings panel, click Inventory.

6 In the Catalog list, click Collection Data Form Schedule.

7 In the Inventory panel, click Override settings.

This overrides both the Management Zone and folder settings.

8 In the Schedule Type field, configure the schedule you want to use.

For configuring the schedule type, perform steps from Step 3 on page 50 through Step 3 on 
page 57 listed in Section 4.3.1, “Scheduling the Deployment of the Collection Data Form for 
the Management Zone,” on page 50.

4.4  Deploying the Data Collection Form Using a 
Quick Task
Using a device Quick Task deploys the Collection Data Form to one or more devices in a folder.

To deploy the Collection Data Form using a device Quick Task:

1 In ZENworks Control Center, click Devices.

2 Click the folder containing the device you want to inventory.

3 Select the device or devices you want to inventory.

4 Click Quick Tasks > Inventory Wizard.

The Quick Task Status dialog box shows the progress of the deployment. When complete, the 
Collection Data Form appears on the screen of the device or devices. You can stop the 
deployment by selecting the workstation and clicking Stop.
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5 Click Hide to close the dialog box.

4.5  Deploying the Data Collection Form Using a 
Device Task
Using a device task deploys the Collection Data Form to a specified workstation.

To deploy the Collection Data Form using a device task:

1 In ZENworks Control Center, click Devices.

2 Click the folder containing the device you want to inventory.

3 Click the device you want to inventory.

4 In the Device Tasks list, click Device Inventory Wizard.

The Quick Task Status dialog box shows the progress of the deployment. When complete, the 
Collection Data Form appears on the screen of the device. You can stop the deployment by 
selecting the workstation and clicking Stop.
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5 Click Hide to close the dialog box.

4.6  Scanning Demographic Data on an Inventory 
Only Device
Inventory Only Devices don’t use the Collection Data Form to gather demographic data. 
Demographic data for an Inventory Only device must be entered manually into a file named 
demodata.txt and saved on the device. This data is then gathered during an inventory scan. 

You can scan for the demographic data only on Windows, Macintosh, UNIX, and Linux. 

To enable demographic data to be gathered from an Inventory Only device:

1 Create a file called demodata.txt.

The file should reside in the following location:

 For Windows, C:\Program Files\Novell\ZENworks\bin

 For Macintosh, /usr/local/novell/zenworks/umia

 For UNIX/Linux, /opt/novell/zenworks/umia

2 Enter demographic data into the file using the format shown below.

The example below shows all the fields that can be included as well as various field formats; 
however, only those fields that are actually entered need to be in the file. Examples of field 
formats that are shown is as follows:

 nc_user.ADF10 shows how to enter a date

 nc_user.ADF11 shows how to enter a time

 nc_workstation.ADF10 shows how to enter currency

 nc_workstation.ASF11 shows how to enter a number (decimal or integer)
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NOTE: Only those Administrator-Defined Fields that have been configured through 
ZENworks Control Center have data from this file stored.

3 Save the file.

4 Configure and run un an Inventory Only scan as shown in Section 3.1, “Configuring an 
Inventory Only Scan,” on page 33 and Section 3.2, “Scheduling an Inventory Only Scan,” on 
page 36.
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5
5Importing Demographic Data

Importing demographic data is the process of automatically populating the Novell ZENworks 
database with demographic information from Microsoft Active Directory and Novell eDirectory. 
The demographic information is comprised of the inventory data associated with users, 
workstations, or other entities. 

For information on the supported versions of Microsoft Active Directory and Novell eDirectory, see 
“LDAP Directory Requirements” in the ZENworks 10 Asset Management Installation Guide.

This section includes the following topics:

 Section 5.1, “Creating LDAP Import Tasks,” on page 63

 Section 5.2, “Viewing or Editing LDAP Import Tasks,” on page 68

5.1  Creating LDAP Import Tasks
1 In ZENworks Control Center, click Configuration > Asset Inventory.

2 In the LDAP Import Tasks panel, click New to launch the New LDAP Import Task Wizard. 
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3 Complete the wizard by using information from the following table to fill in the fields.

Wizard Page Details

Define Details page Fill in the following fields: 

 Name: Provide a unique name for the import task. The name 
cannot include any of the following characters: / \ * ? : " ' < > | ` % 

If you want to use numeric characters in a name, you must include
characters like _ , #, or ^ between the name and numeric value. A
numeric value cannot immediately follow an alphabetic character.
For example, if there is an existing task name ABC, you can create
a new task with a name ABC_1 but not ABC1. 

 Description: Provide a short description for the import task. This
description is displayed in the LDAP Import Task Details panel of 
ZENworks Control Center.

Enter LDAP Settings page > 
Search pre-configured LDAP 
source option

The Enter LDAP Settings page lets you identify the LDAP directory 
against which you want to perform the import task.

A preconfigured LDAP source is one that has already been defined as a
user source in your Management Zone. For information on how to 
create a user source, see “Adding User Sources” in the ZENworks 10 
Asset Management System Administration Reference. 

If you want to create a new connection to the LDAP directory, see 
“Enter LDAP Settings page > Specify a new LDAP source option” on 
page 65. 

To use an existing connection to the LDAP directory:

1. Select Search pre-configured LDAP source from the drop-down 
list.

2. In the Source to Search list, select the LDAP source you want to 
search. 

The Source to Search list contains only the directories that have 
been defined as user sources within your Management Zone.
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Enter LDAP Settings page > 
Specify a new LDAP source 
option

The Enter LDAP Settings page lets you create a new connection to the
LDAP directory to import inventory information. 

A new LDAP source is one that was defined as a new source when the
import task was created. 

If you want to use an existing connection, see “Enter LDAP Settings 
page > Search pre-configured LDAP source option” on page 64.

To create a new connection to the LDAP directory:

1. Select Specify a new LDAP source from the drop-down list. 

2. Fill in the following fields:

LDAP Server: Provide the IP address or DNS hostname of the 
server that has LDAP directory installed. 

LDAP Port: Select the LDAP port number. The default is standard
SSL port (636) or non-SSL port (389), depending on whether this
option is enabled or disabled. If your LDAP server is listening on a
different port, select that port number. 

LDAP Root Context: Provide the root context to establish the 
entry point in the directory. If you do not provide a root context, the
directory’s root container becomes the entry point. 

Credentials: Provide the credentials to acquire read-only access
to the directory. You can have more than read-only access, but 
read-only access is all that is required and recommended.

When accessing eDirectory, ensure that the account has read 
rights to the following:

 WM:NAME DNS attributes on the workstation and server 
objects

 All those attributes you want to import

To add the credentials:

a. Click Add to display the Enter Credential Information dialog 
box.

b. In the Type drop-down list, select LDAP. 

c. In the Username field, specify the appropriate username.

For Novell eDirectory access, use standard LDAP notation. 
For example, 
cn=admin_read_only,ou=users,o=mycompany

For Microsoft Active Directory access, use standard domain
notation. For example, AdminReadOnly@mycompany.com

d. In the Password and Reenter Password fields, specify the 
user password.

e. Click OK.

3. (Optional) To save the credentials, select the Save credentials to 
datastore option.

The saved credentials are encrypted in the database for increased
security. 

Wizard Page Details
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Credentials that are not saved are cleared from memory when the 
ZENworks Server is restarted. If you are creating a scheduled import 
task, you should save the credentials to ensure that they are still 
available when the import task is performed. 

Map Fields page > Key option The Map Fields page displays the LDAP directory fields on the left and
ZENworks Inventory fields on the right. The ZENworks Inventory Fields
list displays:

 A small subset of possibly hundreds of classes defined in your 
LDAP source, showing only those relevant to ZENworks Asset 
Inventory. 

 All the Workstation and User administrator-defined fields. 

The Key option lets you define a key assignment for the LDAP Import 
task. You must define a key assignment for each task to uniquely 
identify the mapped fields. You can define only one key for each task. 

Key is a unique value that is assigned by mapping an LDAP field to a 
unique ZENworks Inventory field. When a task runs, the key field is 
searched for the stored key value. If the key is unique, the data from the
specified LDAP fields is imported to the specified ZENworks Inventory 
fields. If the key is not unique, only the first hit is selected for mapping,
which might result in incorrect mappings.

To define a key assignment:

1. In the LDAP Fields list, locate the field. 

2. In the ZENworks Inventory Fields list, select a corresponding key
field from a similar class. 

All workstation-based LDAP fields can be mapped only to the 
ZENworks Inventory fields belonging to a Device class. Similarly,
all user-based LDAP fields can be mapped only to the ZENworks
Inventory fields belonging to a User class. Thus, you need to 
create two independent tasks for workstation- and user-based 
fields. 

For example, while importing data from Active Directory, you wan
to define a key for the LDAP field called name belonging to a 
computer class (which is unique across the organization), you can
select the ZENworks Inventory field called Machine Name 
belonging to a Device class. 

3. Click Key.

After you define a key, “= [LDAP Fields class] / [LDAP Fields 
name]” is appended to the selected ZENworks Inventory field. 

For example, if you want to define the LDAP field called name 
belonging to a computer class and the ZENworks Inventory field 
called Machine Name belonging to a Device class as the key 
fields, the Inventory Device class Machine Name field changes to
Machine Name = computer / name.

Wizard Page Details
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Map Fields page > Map option The Map option lets you map one or more LDAP directory fields to the
corresponding fields in the ZENworks Inventory database. 

To map an LDAP directory field to the corresponding ZENworks 
Inventory field:

1. In the LDAP Fields list, locate a field you want to map. 

2. In the ZENworks Inventory Fields list, select a corresponding field
from a similar class. 

All workstation-based LDAP fields can be mapped only to the 
ZENworks Inventory fields belonging to a Device class. Similarly,
all user-based LDAP fields can be mapped only to the ZENworks
Inventory fields belonging to a User class. Thus, you need to 
create two independent tasks for workstation- and user-based 
fields. 

For example, while importing data from Active Directory, you wan
to map the LDAP field called displayName belonging to a user 
class, you can map it to the ZENworks Inventory field called First
Name belonging to a User class. 

3. Click Map.

After you map the fields, “<- [LDAP Fields class] / [LDAP Fields 
name]” is appended to the selected ZENworks Inventory field.

For example, if you want to map the LDAP field called 
displayName belonging to a user class to the ZENworks Inventory
field called First Name belonging to a User class, the ZENworks 
Inventory User class First Name field changes to First Name <- 
user / displayName.

If the size of the selected LDAP field exceeds the size of the 
corresponding ZENworks Inventory field, the data is truncated to 
the maximum size of storage and an error message is displayed in
the Last Import Messages column. For more information on the 
error, see loader-messages.log located in 
%ZENWORKS_HOME%\logs\ on Windows and in /var/opt/
novell/log/zenworks/loader-messages.log on Linux. 

4. (Optional) To map additional fields, repeat Step 1 through Step 3.

Map Fields page > Remove 
option

To remove a field mapping:

1. In the ZENworks Inventory Fields list, click a mapped field that you
want to remove.

2. Click Remove.

To remove a key assignment from the selected field: 

1. In the ZENworks Inventory Fields list, click a field that is defined as
a key.

2. Click Remove.

You must again define a key to uniquely identify the mapped fields
For more information, see “Map Fields page > Key option” on 
page 66. 

Wizard Page Details
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When you finish the wizard, the import task is listed in the LDAP Import Tasks panel. You can use 
the panel to monitor the status of the task. If the key is unique, the data from the LDAP fields is 
imported to the ZENworks Inventory fields based on the mapped assignments. 

IMPORTANT: Before running a task, ensure that all the existing tasks are in a finished state. For 
more information, see the troubleshooting scenario “LDAP Import Tasks remain in a pending state if 
run simultaneously” on page 110. 

5.2  Viewing or Editing LDAP Import Tasks
To view or edit the LDAP import task settings:

1 In ZENworks Control Center, click Configuration > Asset Inventory. 

Set the Import Schedule page Configure the schedule when you want to run the import task, then click
OK. 

 To immediately run the task after it is created, click Now.

 To set up a schedule: 

1. Click On a schedule, then select one of the following 
schedules:

 No Schedule: Indicates that no schedule has been set
The task does not run until a schedule is set or the task
is manually launched. This is useful if you want to 
create the task and come back to it later to establish the
schedule or run the task manually.

 Date Specific: Specifies one or more dates on which to
run the task.

 Recurring: Identifies specific days each week, month,
or on a fixed interval on which to run the task.

IMPORTANT: Ensure that you do not set the same or 
simultaneous schedule for multiple tasks. If you do so, the 
scheduled tasks might not run. For more information, see the
troubleshooting scenario “LDAP Import Tasks remain in a 
pending state if run simultaneously” on page 110. 

2. (Conditional) If you selected Date Specific or Recurring for 
the schedule, fill in the schedule’s fields.

For more information on the schedules, click the Help button

Select Primary Server page Select the ZENworks Server that you want to perform the LDAP impor
task. 

Wizard Page Details
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2 In the LDAP Import Tasks panel, click a task whose settings you want to view or edit. 

The Summary tab lists the settings configured for the task:

 GUID: Displays the task’s globally unique identifier (GUID), which is a randomly 
generated string that provides a unique identifier for the task. You cannot edit the GUID. It 
remains the same as long as the task exists. 

 Description: Displays the task’s description, if one was provided when the task was 
created. The description appears only in ZENworks Control Center. 

 Primary Server: Displays the ZENworks Server name that is assigned to perform the 
discovery task. 

 Schedule: Displays when the task is scheduled to run. 

 Configured LDAP Server: Displays the IP address of the server that hosts the LDAP-
based directory server.

 Mappings: Displays all the mapped and key assignments established between the LDAP 
directory and ZENworks Inventory fields.

3 (Conditional) If the information for a device is incorrect or insufficient, click Edit and manually 
change the details for the fields. 

If you configure another LDAP server, some of the mapped and key assignments might become 
incorrect. In this case, you must verify the assignments and map the fields again. 

For more information on how to map the fields, see “Map Fields page > Map option” on 
page 67. 

For more information on how to define a key assignment, see “Map Fields page > Key option” 
on page 66. 
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6
6Creating Local Software Products

The following sections provide information about Local Software Products: 

 Section 6.1, “Understanding Local Software Products,” on page 71

 Section 6.2, “Understanding the Local Software Products Panel,” on page 71

 Section 6.3, “Creating Local Software Products,” on page 72

 Section 6.4, “Consolidating Local Software Products,” on page 74

 Section 6.5, “Editing Product Information,” on page 74

 Section 6.6, “Updating the ZENworks Knowledgebase,” on page 77

6.1  Understanding Local Software Products
Software applications discovered in an inventory scan are identified by specific files associated with 
the product. These identifications are kept locally in the ZENworks Knowledgebase, which can be 
updated by downloading and installing the latest Product Recognition Update (PRU). To identify 
products that aren’t in the knowledgebase, you can search for files that are associated with an 
unknown product and use the file information to create a new product identification called a Local 
Software Product. This Local Software Product information can then be merged with the 
knowledgebase so that these new products are recognized in subsequent scans.

The procedure is as follows:

1. Collect software files using an inventory scan.

2. Run a report for software files.

3. Create Local Software Products based on the collected files.

4. Update the ZENworks Knowledgebase with the new products.

For more information on this procedure, see Section 6.3, “Creating Local Software Products,” on 
page 72.

6.2  Understanding the Local Software Products 
Panel
To access the Local Software Products panel, click Configuration in ZENworks Control Center, then 
click the Asset Inventory tab.

Figure 6-1   Local Software Products Panel
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This panel shows Local Software Products that have already been created, along with the following 
details:

 Manufacturer: The manufacturer of the product.

 Product: The name of the product. Click the product name to open the Local Software Product 
Detail page where you can edit product and file details. 

 Version: The product version.

 File: A list of files associated with the product.

 Installations: The number of installations of the Local Software Product in the Management 
Zone.

6.3  Creating Local Software Products
Local Software Products are created from software files associated with a product. Before you can 
create a Local Software Product, you need to run an inventory scan that has been configured to 
search for those files. For information on configuring and running an inventory scan, see Chapter 2, 
“Scanning Managed Devices,” on page 13 and Chapter 3, “Scanning Inventory Only Devices,” on 
page 33.

To create local software products:

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Local Software Products panel, click either New > Create from Software Files by 
Machine or New > Create from Unique Software Files.

Clicking Create from Software Files opens a report definition that you can run to list all the 
software files on each machine in the Management Zone according to the way the inventory 
scan was configured. 

Clicking Create from Unique Software Files opens a report definition that you can run to list all 
the software files that are not associated with a known software product as identified in the 
ZENworks Knowledgebase. The files are identified using Version Recognition Block (VRB) 
product information.
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3 Click Run. 

4 Select the files you want to use to create Local Software Products. 

This page also allows you to edit the report definition and export the records to Excel, CSV, and 
PDF formats. For more information on editing the report definition, see Section 8.2.6, “Editing 
a Custom Report,” on page 92.

5 Click Create Local Products.

A dialog box appears, confirming that the products have been created.
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6 Click Close.

The selected products appear in the Local Software Products panel on the Configuration page.

6.4  Consolidating Local Software Products
If you have several files in the Local Software Products panel that identify the same product, you 
can consolidate them into one.

To consolidate two or more files:

1 In ZENworks Control Center, click Configuration.

2 Click the Asset Inventory tab.

3 In the Local Software Products panel, select the files you want to merge.

4 Click Action > Merge Selected Products.

5 Select a target product in the Target Product field.

6 Click OK.

The target product is displayed with its component files, which are shown in the File column.

6.5  Editing Product Information
ZENworks Control Center allows you to edit both product naming data and product recognition data 
of a local software product. For more information, see the following sections:

 Section 6.5.1, “Editing the Product Naming Data,” on page 74

 Section 6.5.2, “Editing the Product Recognition Data,” on page 76

6.5.1  Editing the Product Naming Data

1 In ZENworks Control Center, click Configuration.

2 Click the Asset Inventory tab.

3 In the Local Software Products panel, click a product.
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The Local Software Product Detail page shows details about the local software product and the 
files used to identify it. From here, you can edit the product information or the Version 
Recognition Block (VRB) data for the identifying files. If the file associated with the product 
does not contain Version Resource Block (VRB) information, the fields show “Unnamed.”

4 Edit the fields in the Product Naming section.

Manufacturer: The manufacturer of the product.

Product: The name of the product.

Version: The version of the product. 

Category/Subcategory: The type of product. You can create your own categories and 
subcategories. For more information, see Section 10.3, “Managing Product Categories and 
Subcategories,” on page 102.

Distribution: The type of distribution:

 Commercial

 Freeware

 Shareware

 Open Source

 Multiple

 Public Domain

License Type: The software product’s license type:

 Full

 Evaluation

 OEM

 Multiple

 Network License
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Current Manufacturer: The product’s current manufacturer.

Use for Version Reporting: Select Use for Version Reporting to use the product version for 
recognition purposes. You can use either the product version or the file version for recognition 
purposes. If you want to specify a version in the Version field to be used in the product 
definition, specify a value and select Use for Version Reporting. You can use either the product 
version or the file version for identification. To use the file version, select Version Reporting in 
the Product Recognition section.

5 Click Apply or OK. 

6.5.2  Editing the Product Recognition Data

1 In ZENworks Control Center, click Configuration.

2 Click the Asset Inventory tab.

3 In the Local Software Product panel, click a product.

4 In the Product Recognition section, select the file you want to edit. If you want to use the file 
version for version reporting instead of the product version, select Version Reporting for that 
file.

5 Click Edit.
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6 Edit the File Attributes fields.

File: The name of the file.

Extension: The file’s extension.

Size: The size of the file. Use the arrow icons to change the file size.

Date: The date the file was created. Click the calendar icon to select a different date.

7 Edit the Version Resource Block (VRB) data.

Company Name: The manufacturer of the file. To use this data as part of the recognition 
criteria, select Use for recognition.

Product Name: The name of the product. To use this data as part of the recognition criteria, 
select Use for recognition.

Product Version: The version of the product. To use this data as part of the recognition 
criteria, select Use for recognition. To use the product version instead of the file version for 
recognition, select Report the version found here.

File Version: The version of the file. To use this data as part of the recognition criteria, select 
Use for recognition. To use the file version instead of the product version for recognition, select 
Report the version found here.

Language: The associated language. The available languages are shown in the drop-down list.

8 Click OK on the Edit Product Recognition File page.

9 Click OK on the Local Software Product Detail page.

6.6  Updating the ZENworks Knowledgebase
The ZENworks Knowledgebase is updated in two ways:

 Merging with Local Software Products

 Merging with the Product Recognition Update (PRU)

The Knowledge Base Status panel (Configuration > Asset Inventory) shows the date of the latest 
Product Recognition Update (PRU) and if there are newly defined local software products ready to 
merge with the knowledgebase.
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Figure 6-2   Knowledge Base Status Panel

6.6.1  Merging Local Software Products with the ZENworks 
Knowledgebase

After a Local Software Product is created, you can add it to the ZENworks Knowledgebase so that 
subsequent scans will identify the product on devices. The Knowledge Base Status panel on the 
Asset Inventory page (Configuration > Asset Inventory) shows when there are products ready to be 
merged. 

1 In ZENworks Control Center, click the Configuration tab.

2 Click the Asset Inventory tab.

3 In the Local Software Products panel, click Action > Update Knowledgebase with Local 
Product Changes.

A dialog appears reminding you that updates should only made after all local product changes 
are complete. For information on editing local product data, see Section 6.5, “Editing Product 
Information,” on page 74.

4 Click OK.

This action merges the listed software products with the knowledgebase.

6.6.2  Updating the ZENworks Knowledgebase with the PRU

1 In ZENworks Control Center, click Configuration.

2 Click the System Updates tab.

3 In the System Update Overview panel, click Action > Download and Install PRU Now.

The new PRU is applied, or a message appears telling you that your knowledgebase is up to 
date.
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7
7Using Administrator-Defined 
Fields

The following sections provide information about Novell ZENworks 10 Asset Management features 
and procedures for administrator-defined fields.

 Section 7.1, “About Administrator-Defined Fields,” on page 79

 Section 7.2, “Creating an Administrator-Defined Field,” on page 79

7.1  About Administrator-Defined Fields
Administrator-defined fields allow you to add custom fields to inventory data. There are four types 
of fields:

 User: Used for gathering demographic data about the workstation user through the Collection 
Data Form.

 Workstation: Used for gathering demographic data about the workstation through the 
Collection Data Form.

 Component: Used for defining inventory data about a component.

 Product: Used for defining inventory data about a product.

Figure 7-1   Administrator-Defined Fields Panel

The Administrator-Defined Fields panel shows the type of field and the number of defined values. 
When you create a User or Workstation field, it appears on the Collection Data Form as a field for 
workstation users to fill out. Component and Product field values are added to the properties of the 
component or product. You can change the field value of an individual component or product by 
performing a product or component search, clicking the product or component, and editing the field 
value on the Product Details page. For more information, see Chapter 9, “Managing Component 
Data,” on page 97 and Chapter 10, “Managing Product Data,” on page 101.

7.2  Creating an Administrator-Defined Field
Regardless of the type of administrator-defined field you want to create, the steps are the same, 
whether it is a User, Workstation, Component, or Product field.

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Administrator-Defined Fields panel, click the type of field you want to create: User, 
Workstation, Component, or Product.
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The User Fields panel shows existing defined fields, along with the following information:

Name: The name of the field.

Data Type: The data type: character, integer, decimal, or date.

Size: The number of alphanumeric characters. This applies only to character-type fields.

Edit Type: Specifies how the user enters a response. The values are Edit, List, and Combo.

Default Value: The value that is specified when the field is created.

Internal Name: The field’s internal ID.

3 Click New.

4 Fill in the fields:

Type: Filled in by default depending on the type of field you selected.

Name: Name of the administrator-defined field. This field is required.

Default Value: The default value of the field.

Data Type: Character, Integer, Decimal, or Date.

Size: The maximum number of alphanumeric characters allowed in the field. This applies only 
to character-type fields.

Edit Type: Allows greater flexibility in entering and selecting field values. There are three 
options:

 Edit: Allows the user to enter a value or edit the default value.

 List: Allows the user to select a value from a list of possible choices.

 Combo: Allows the user to enter a value or select from a list.
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Edit Mask: Select a format from the Edit Mask field list to restrict how a value is entered. The 
choices are phone, time, and currency. This applies only to character-type fields.

5 Click Next.

6 If you chose List or Combo as the Edit Type in Step 4 on page 80, specify a list of choice values 
and click Next.

6a Specify a value in the Choice List Values field.

6b Click Add. Repeat for additional values.

6c Repeat Step 6a on page 81 and Step 6b on page 81 for additional values.

6d (Optional) Select a value and click Edit to change it.

6e (Optional) Select a value and click Remove to remove it.

6f (Optional) Import a list of values by clicking Import and specifying a file in the Import 
File field.

7 Click Finish to create the new field.
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8
8Using Reports

Reports allow you to view and analyze inventory data from your Management Zone. ZENworks 
Control Center includes predefined reports you can run along with reports you can customize. This 
section includes the following topics:

 Section 8.1, “Using Inventory Standard Reports,” on page 83

 Section 8.2, “Using Inventory Custom Reports,” on page 86

 Section 8.3, “Inventory Report Rights,” on page 95

8.1  Using Inventory Standard Reports
Standard or predefined reports scan your inventory data and arrange the data according to the report 
configuration. More information is available in the following topics:

 Section 8.1.1, “Available Standard Reports,” on page 83

 Section 8.1.2, “Running a Standard Report,” on page 85

8.1.1  Available Standard Reports

ZENworks Control Center includes several predefined reports you can use to analyze the inventory 
in your Management Zone. These reports are grouped into folders according to their function. The 
available folders and reports are as follows:

 Device Lists (folder): Reports focusing on device details.

 Devices by Machine / Login Name: Lists all devices by machine and login name.

 Devices by Mfg / Model: Shows a count of systems by manufacturer and model.

 Lease Details: Shows leased devices by contract along with the expiration date.

 Devices with Virtual Machines: Shows devices with host virtual machines that have 
been scanned.

 Duplicate Asset Tags: Shows devices with duplicate asset tags.

 Duplicate Machine Names: Shows devices with duplicate machine names.

 Duplicate Serial Numbers: Shows devices with duplicate serial numbers.

 Software Applications (folder): Reports focusing on software applications. 

 Antivirus Details: Shows antivirus definition files with links to the devices where they 
are installed.

 Software Applications by Category: Shows a count of installed software products 
grouped by category and subcategory.

 Software Applications by Manufacturer: Shows a count of installed products grouped 
by manufacturer.

 Software Applications by OS and Product: Shows a count of installed products 
grouped by operating system and product name.
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 Duplicate Serial Numbers: Shows software products that have multiple instances of the 
same serial number. 

 High Bandwidth Applications: Shows a count of high-bandwidth products, such as 
multimedia and file-sharing software.

 Hot Fix Details: Shows hot fixes and security patches with links to descriptions of the 
fixes and patches and the machine that they were installed on.

 Microsoft Products: Shows a count of installed Microsoft products grouped by 
classifications specific to Microsoft.

 Operating Systems: Shows a count of devices grouped by the installed operating system.

 OS Service Packs: Shows a count of devices grouped by operating system and service 
pack.

 Software Files (folder): Reports focusing on software files, grouping them by category, 
manufacturer, and device.

 Software Files by Category: Shows a count of software files grouped by category (All, 
Other, Ancillary, and System) with links to lists of the files.

 Software Files by Manufacturer: Shows a count of software files grouped by 
manufacturer with links to lists of the files.

 Software Files by Device: Shows a count of software files grouped by device with links 
to lists of the files.

 Hardware Components (folder): Reports focusing on hardware data. 

 BIOS: Shows installed versions and release dates grouped by manufacturer.

 Hardware Components by Category: Shows a count of installed hardware products by 
category and subcategory.

 Hardware Components by Manufacturer: Shows a count of installed hardware 
products grouped by manufacturer.

 Disk Space: Shows a count of devices with total disk space within a specific range.

 Duplicate Serial Numbers: Shows hardware products with the same serial number.

 Free Disk Space: Shows a count of devices with free disk space within specific ranges.

 Memory Size: Shows a count of devices grouped by RAM size.

 Processors: Shows a count of devices grouped by CPU speed.

 Upgrade Readiness (folder): Reports that help you determine which devices are ready for an 
upgrade.

 Memory Upgrade: Lists devices along with data on memory and available slots.

 SLED 10 Ready / Not Vista Capable: Shows devices ready for SUSE Linux Enterprise 
Desktop 10 that are not ready for Windows Vista.

 SLED 10 Ready / Not Vista Premium Ready: Shows devices ready for SUSE Linux 
Enterprise Desktop 10 that are not ready for Windows Vista Premium. 

 SUSE Enterprise Desktop: Lists devices along with data showing whether the device is 
ready or not ready for SUSE Linux Enterprise Desktop.

 Windows 2003 Server: Lists devices along with data showing whether the device is 
ready or not ready for Windows Server 2003.

 Windows Vista Capable: Shows devices capable of running Windows Vista.
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 Windows Vista Premium Ready: Shows devices capable of running Windows Vista 
Premium.

 Windows XP Professional: Shows devices along with data showing whether the device 
is ready or not ready for Windows XP Professional.

8.1.2  Running a Standard Report

1 In ZENworks Control Center, click Reports.

2 In the Inventory Standard Reports panel, click the folder containing the report you want to run.

Reports are listed by name and description. For a list of reports and descriptions, see 
Section 8.1.1, “Available Standard Reports,” on page 83.

3 (Optional) Select how you want to filter your search.

You can limit the scope of the report data by any of the following:

 Zone: Select Zone to collect data from the entire Management Zone.

 Folder: Select Folder and specify a folder name to gather data about that folder.

 Group: Select Group and specify a group name to gather data about that group.

 Demographic: Select Demographic, then select the criteria you want to use to filter the 
data.
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4 Click a report to run it.

Click the various links on the report for additional information. You can export the report to an 
Excel, CSV, or PDF format by clicking the corresponding link. In some reports, you can also 
click Graph to view the data in a bar graph, pie chart, or line graph format.

8.2  Using Inventory Custom Reports
ZENworks Control Center allows you to create and run custom reports that you can use to analyze 
the inventory in your Management Zone. These sections provide more information:

 Section 8.2.1, “Available Custom Reports,” on page 86

 Section 8.2.2, “Running a Custom Report,” on page 87

 Section 8.2.3, “Creating a Custom Report,” on page 88

 Section 8.2.4, “Scheduling a Custom Report and Sending Notifications,” on page 90

 Section 8.2.5, “Configuring E-mail Addresses,” on page 91

 Section 8.2.6, “Editing a Custom Report,” on page 92

 Section 8.2.7, “Moving a Custom Report,” on page 93

 Section 8.2.8, “Deleting a Custom Report or Folder,” on page 94

 Section 8.2.9, “Viewing Scheduled Reports by Date and Title,” on page 94

 Section 8.2.10, “Importing New Report Definitions,” on page 95

8.2.1  Available Custom Reports

ZENworks Control Center includes several predefined reports you can use to analyze the inventory 
in your Management Zone. These reports are grouped into folders according to their function. The 
available folders and reports are as follows:

 Hardware Components (folder): Reports focusing on hardware components, such as BIOS 
and system details.

 BIOS and System Details: Shows the BIOS details for all current systems.

 Hardware added or deleted in last 6 months: Lists the hardware components in the 
Management Zone and shows the number of additions and deletions over the previous 6 
months.

 USB devices added in last 30 days: Shows the workstations that have had a USB device 
added in the previous 30 days.

 Workstations with memory deletions in last 30 days: Shows the workstations that have 
had memory module deletions during the previous 30 days.

 Local Product Creation (folder): Reports focusing on software files that can be used to create 
Local Software Products. For more information on Local Software Products, see Chapter 6, 
“Creating Local Software Products,” on page 71.

WARNING: If you rename, move or delete the Local Product Creation folder or its 
contents, you will not be able to create the Local Software Products. 

 Software Files by Machine: Shows the software files on each machine. You can use this 
report to create Local Software Products.
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 Unique Software Files: Shows the software files along with Version Resource Block 
(VRB) data. You can use this report to create Local Software Products.

 Software Applications (folder): Reports focusing on software applications, such as how many 
applications were added during a specified time.

 SW apps added in last 30 days (by product): Shows the software applications that were 
added during the previous 30 days, grouped by product.

 SW apps added in last 30 days (by workstation): Shows the software applications that 
were added during the previous 30 days, grouped by workstation.

 SW apps deleted in last 30 days (by product): Shows the software applications that 
were deleted during the previous 30 days, grouped by product.

 SW apps deleted in last 30 days (by workstation): Shows the software applications that 
were deleted during the previous 30 days, grouped by workstation.

 Workstations with antivirus software: Shows the Windows workstations (not marked 
as deleted) with antivirus software installed.

 Workstations with suspicious software installed: Shows the workstations with 
suspicious software installed.

 Workstations without antivirus software: Shows the Windows workstations (not 
marked as deleted) without antivirus software installed.

 Systems (folder): Reports focusing on system details, such as how many systems were added 
during a specified time.

 Hosts of Virtual Machines: Shows the systems that are hosting virtual machines.

 Systems added in last 90 days: Shows the systems (Windows, UNIX/Linux) that were 
added to the inventory database during the last 90 days.

 Systems deleted in last 90 days: Shows the systems (Windows, UNIX/Linux) that were 
deleted during the previous 90 days.

 Systems that have not loaded results in 90 days: Shows the systems (Windows, UNIX/
Linux) that have not been marked as deleted and have not loaded scan results during the 
previous 90 days.

 Systems with less that 100 MB free space: Shows the systems (Windows, UNIX/Linux) 
that have not been deleted and have less than 100MB free disk space.

 Systems with less that 128 MB memory: Shows the systems (Windows, UNIX/Linux) 
that have not been deleted and have less than 128MB total memory.

 Virtual Machines: Shows the virtual machines in your Management Zone.

8.2.2  Running a Custom Report

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder containing the report you want to run.

The number of reports in each folder is shown in the Report Count column.
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3 Click a report.

4 Click Run in the lower left corner.

On the report page, click the various links on the report for additional information. You can 
export the report to an Excel, CSV, or PDF format by clicking the corresponding link. 

8.2.3  Creating a Custom Report

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder where you want to save the report, or 
create a new folder by clicking New, specifying a folder name, then clicking OK.

3 Click New.
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4 Specify a name in the Name field.

5 Select the report type. The types are:

 Devices

 Software Applications

 Software Files

 Hardware Components

 License Management

6 Select the focus of the report. The options are:

 Basic Device Attributes

 Product Filtering

 File Filtering

 History

7 Click Continue.
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8 Fill in the following fields:

Name: Specify the name of the report.

Folder: Select a folder where you want to save the report.

Description: Specify a description for your report.

Type: This field is display only. It shows the report type you selected.

Columns: From the list on the left, select what data you want to include in your report. Use the 
arrow icons to move the selected data to the list on the right. Use Ctrl+click to select more than 
one option at a time. Use the up and down icons to arrange how you want the data displayed.

Criteria: Select your filter criteria in the Field, Operator, and Value fields. Use the + icons to 
add filters; click the - icon to delete a filter. Click OR or AND to toggle back and forth between 
the two operators.

Summary Criteria: Select your summary filter criteria in the Field, Operator, and Value 
fields. Use the + icons to add filters; click the - icon to delete a filter. Click OR or AND to 
toggle back and forth between the two operators

9 Click Save.

8.2.4  Scheduling a Custom Report and Sending Notifications

You can schedule a report to run automatically and send out notifications to specified people when 
the report is ready. To schedule a report and configure notifications:

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder containing the report you want to 
schedule.

3 Click the report you want to schedule.

4 Click Schedule/Notification.
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5 Fill in the following fields:

Start Date: Click the calendar icon to specify a date.

Frequency: Select how often you want to send the notification: yearly, monthly, weekly, daily, 
once, or never.

Output: Select whether you want to store the report, send an e-mail notification that the report 
is ready, or both. You can also choose to store the results or send a notification only when 
matching records are found. For information on configuring e-mail addresses, see 
Section 8.2.5, “Configuring E-mail Addresses,” on page 91.

Maximum Records: Specify the maximum number of records to store.

6 Click Submit.

8.2.5  Configuring E-mail Addresses

You can send notifications to selected people when a custom report is run. To do this, you need to 
import the e-mail addresses of those you want to notify into ZENworks Control Center. For 
information on sending notifications, see Section 8.2.4, “Scheduling a Custom Report and Sending 
Notifications,” on page 90.

The E-mail Addresses panel on the Configuration page allows you to import e-mail addresses that 
can be used to send notifications when a custom report is ready, as configured in the report 
definition. Previously imported e-mail addresses are listed in the panel, along with the user’s first, 
last, and middle name.

To import e-mail addresses:

1 In ZENworks Control Center, click Configuration.

2 Click the Asset Inventory tab.

3 In the E-mail Addresses Panel, click Action > Manage E-mail Addresses.

4 In the Import From field, select either Inventory Data or Comma Separated File.
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If you select Inventory Data, the e-mail addresses found in an inventory scan will be imported.

If you select Comma Separated File, specify the file location in the E-mail Address File field.

5 Click Import.

6 Click Close.

To delete all e-mail information:

1 In ZENworks Control Center, click Configuration.

2 In the E-mail Addresses Panel, click Action > Manage E-mail Addresses.

3 Click Delete.

4 Click OK.

All e-mail information is deleted.

8.2.6  Editing a Custom Report

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder containing the report you want to edit.

3 Click the report.

4 Click Edit in the lower left corner.
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5 Edit the following fields:

Name: The name of the report.

Folder: The folder where you want to save the report.

Description: The description for your report.

Type: This field is display only. It shows the report type you selected.

Columns: From the list on the left, select what data you want to include in your report. Use the 
arrow icons to move the highlighted data selection to the list on the right. Use Ctrl-click to 
select more than one option at a time. Use the up and down icons to arrange how you want the 
data displayed.

Criteria: Select your filter criteria in the Field, Operator, and Value fields. Use the + icons to 
add filters; click the - icon to delete a filter. Click OR or AND to toggle back and forth between 
the two operators.

Summary Criteria: Select your summary filter criteria in the Field, Operator, and Value 
fields. Use the + icons to add filters; click the - icon to delete a filter. Click OR or AND to 
toggle back and forth between the two operators.

6 Click Save.

8.2.7  Moving a Custom Report

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder containing the report or reports you 
want to move.

3 Select the report or reports you want to move.

4 Click Edit > Move.
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5 Select a new folder location.

6 Click OK.

WARNING: If you move reports in the Local Product Creation folder, you will not be able to 
create the Local Software Products. 

8.2.8  Deleting a Custom Report or Folder

To delete a custom report:

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder containing the report you want to 
delete.

3 Select the report you want to delete.

4 Click Delete.

To delete a folder:

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, select the folder you want to delete.

3 Click Delete.

WARNING: 

If you delete reports in the Local Product Creation folder, you will not be able to create the 
Local Software Products.

Deleting a folder deletes all the reports in that folder.

8.2.9  Viewing Scheduled Reports by Date and Title

Reports that are run on a schedule are stored in a database. You can view these reports either by title 
or date. For information on scheduling reports, see Section 8.2.4, “Scheduling a Custom Report and 
Sending Notifications,” on page 90.

To view a scheduled report by date or title:

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click one of the following:

 Action > View Scheduled Report Results by Date

 Action > View Scheduled Report Results by Title
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The Scheduled Reports by Grouping page opens and shows the saved scheduled custom reports 
grouped by date or title and a report count. Click the date or title to open the Scheduled Reports 
page, where you can select a report and view it. To delete a group of reports, select the group 
and click Delete.

8.2.10  Importing New Report Definitions

If you have defined reports in ZENworks Asset Management 7.5, you can import them into 
ZENworks Control Center. You can also re-import reports that have been exported by ZENworks 
Control Center. A predefined XML format is needed for import.

To import report definitions:

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click Action > Import New Report Definition.

3 Specify the file in the Query import file field, or click Browse to search.

4 Click Import.

8.3  Inventory Report Rights
Inventory Report Rights allow you to manage each administrator’s rights for each folder and its 
reports. Each report folder has rights associated with it, governing all the reports within that folder. 
For example, if you have full rights, you can edit a report; but with view/execute rights, you can 
only see the report and run it. With inventory report rights, you can limit who has access to certain 
reports and who can edit them. The report folder type, custom or standard, and the report name are 
listed along with the rights associated with the folder. The choices are:

 Remove all rights: This removes all rights to the folder, so the specified administrator cannot 
see it.

 Assign view/execute rights: This allows the specified administrator to view and execute a 
report in the specified folder, but not to edit, move, or delete a report in that folder.

 Assign full rights: This gives the specified administrator full rights to create, edit, move, and 
delete reports. For standard reports, this setting is the same as View/Execute, because you 
cannot alter a standard report.

To change inventory report rights:

1 In ZENworks Control Center, click Configuration.

2 In the Administrators panel, click an administrator.
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3 In the Administrator Tasks panel, click Inventory Report Rights.

4 Select the desired folders.

5 Click one of the following:

 Edit > Remove All Rights

 Edit > Assign View/Execute Rights

 Edit > Assign Full Rights

The change is reflected in the Rights column.
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9
9Managing Component Data

A component is a hardware or software product associated with a workstation, for example, a 
spreadsheet application or a network interface card. ZENworks Control Center allows you to list a 
workstation’s components or find workstations with a particular component. After you locate the 
component, you can edit the component data, such as the product name and serial number. You can 
examine component data through component searches.

The following sections provide information about managing component data:

 Section 9.1, “Searching for a Component and Viewing Component Data,” on page 97

 Section 9.2, “Editing the Component Data,” on page 98

9.1  Searching for a Component and Viewing 
Component Data
Before you can view component data, you need to perform a component search. Component 
searches are done through the Component Search panel (Configuration > Asset Inventory).

Figure 9-1   Component Search Panel

The Component Search panel allows you to select filters and filter sets to search for a particular 
component, then lists the components along with the following information:

 Machine Name: The name of the machine that has the particular product.

 Manufacturer: The manufacturer of the product.

 Product: The name of the product.

 Version: The version of the product.

 Category: The product category. 

 Subcategory: The product subcategory.

To search for a component and view component data:

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Component Search panel, click Add Filter or Add Filter Set, depending on the filtering 
model you want to use.
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3 Select options for your filter.

For example, you could search by machine name or department.

4 (Optional) Create additional filters or filter sets.

5 Click Search.

Components matching your search criteria are listed, along with additional information about 
the component.

9.2  Editing the Component Data
1 Search for a component, as shown in Section 9.1, “Searching for a Component and Viewing 

Component Data,” on page 97.

2 Click a product name to view the component details.

The Component Details panel opens, displaying the following details about the component, 
along with any administrator-defined fields:

 Machine Name: The name of the machine.

 Product: The name of the product.

 Asset Tag: The asset tag number.

 Serial Number: The component’s serial number.

3 Click Change Product to open the Product Search window, where you can search for and select 
a new product name.
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4 Select your filter criteria, then click Search.

5 Select a product from the list, then click Select Product.

6 Edit the other fields as desired.

7 Click OK or Apply.

9.2.1  Using Administrator-Defined Fields

You can add administrator-defined fields to the Component Details panel to show additional 
information about the component. For example, you could add a field called Malfunctioning, with a 
Yes or No choice selection to show the product’s working status. For more information on creating 
administrator-defined fields, see Chapter 7, “Using Administrator-Defined Fields,” on page 79.
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10
10Managing Product Data

A product is a piece of hardware or software identified by the manufacturer, product name, and 
model/version. ZENworks Control Center allows you to search for products, view details about the 
product, and classify products according to category and subcategory. The following sections 
provide more information about managing product data:

 Section 10.1, “Searching for a Product and Viewing Product Data,” on page 101

 Section 10.2, “Reclassifying a Product,” on page 102

 Section 10.3, “Managing Product Categories and Subcategories,” on page 102

10.1  Searching for a Product and Viewing 
Product Data
Before you can view product data, you need to perform a product search. Product searches are done 
through the Product Search panel (Configuration > Asset Inventory).

Figure 10-1   Product Search Panel

The Product Search panel allows you to select filters and filter sets to search for a particular product, 
then lists the product along with the following information:

 Manufacturer: The manufacturer of the product.

 Product: The name of the product.

 Version: The version of the product.

 Category: The product category. 

 Subcategory: The product subcategory.

To search for a product and view product data:

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Product Search panel, click Add Filter or Add Filter Set, depending on the filtering 
model you want to use.
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3 Select options for your filter.

For example, you could search by product category or type.

4 (Optional) Create additional filters or filter sets.

5 Click Search.

Products matching your search criteria are listed, along with additional information about the 
product.

10.2  Reclassifying a Product
Products are classified by category and subcategory. To change product classification:

1 Search for a product as shown in Section 10.1, “Searching for a Product and Viewing Product 
Data,” on page 101.

2 Click a product name to open the Product Details panel.

3 In the Category/Subcategory field, select a new category/subcategory pair.

For added flexibility, ZENworks Control Center allows you to create new category/subcategory 
pairs. For more information, see Section 10.3, “Managing Product Categories and 
Subcategories,” on page 102.

4 Click OK or Apply.

10.3  Managing Product Categories and 
Subcategories
During an inventory scan, ZENworks Control Center uses a knowledgebase of thousands of 
products to identify scanned products. After they are identified, these products are classified by 
category and subcategory. For added flexibility, ZENworks Control Center allows you to reclassify 
products and create new product categories.
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Categories and subcategories are managed through the Product Categories panel (Configuration > 
Asset Inventory). This panel displays the following information:

 Category Type: The product category, such as CPU or CD-ROM. These are predefined.

 Category Name: The name of the product category.

 Source: Specifies whether the category name is a default value (Novell) or a user-defined value 
(Local). Only Local categories can be edited or deleted.

Figure 10-2   Product Categories Panel

The following sections provide more information about managing product categories and 
subcategories:

 Section 10.3.1, “Creating a New Product Category,” on page 103

 Section 10.3.2, “Renaming a Product Category,” on page 104

 Section 10.3.3, “Deleting a Product Category,” on page 104

 Section 10.3.4, “Creating a New Product Subcategory,” on page 104

 Section 10.3.5, “Renaming a Product Subcategory,” on page 104

 Section 10.3.6, “Deleting a Product Subcategory,” on page 105

10.3.1  Creating a New Product Category

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Product Categories panel, click New.

3 Select a category type in the Category Type field.

4 Specify a name in the Category Name field.

5 Click OK.

The new category is added to the category list with the source shown as Local. You can further 
define this category by assigning a subcategory. For more information, see Section 10.3.4, 
“Creating a New Product Subcategory,” on page 104.
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10.3.2  Renaming a Product Category

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Product Categories panel, select the category you want to rename.

You can only rename categories whose source is Local. 

3 Click Edit > Rename.

4 Specify a new name in the Category Name field.

5 Click OK.

10.3.3  Deleting a Product Category

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Product Categories panel, select the category you want to delete.

You can only delete categories whose source is Local. 

3 Click Delete.

10.3.4  Creating a New Product Subcategory

Creating a subcategory further classifies a product.

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Product Categories panel, select a category that you want to create a subcategory for.

3 Click Action > Manage Subcategories.

The Product Subcategories panel appears, listing any predefined subcategories for the specified 
category, and the subcategory source, Local or Novell.

4 Click New.

5 Specify a name in the Subcategory Name field.

6 Click OK.

10.3.5  Renaming a Product Subcategory

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Product Categories panel, select the category whose subcategory you want to rename.
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You can only rename subcategories whose source is Local. 

3 Click Action > Manage Subcategories.

4 Select the category/subcategory pair.

5 Click Edit > Rename.

6 Specify a new name in the Subcategory Name field.

7 Click OK.

10.3.6  Deleting a Product Subcategory

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Product Categories panel, select the category whose subcategory you want to delete.

You can only delete subcategories whose source is Local. 

3 Click Action > Manage Subcategories.

4 Select the category/subcategory pair you want to delete.

5 Click Delete.
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A
AInventory Workflow

 Section A.1, “Inventory Workflow on a Workstation,” on page 107

 Section A.2, “Inventory Workflow on a Primary Server,” on page 107

 Section A.3, “Troubleshooting the Inventory Workflow,” on page 107

A.1  Inventory Workflow on a Workstation
For any scheduled inventory scan or user-initiated inventory scan, the collector performs the 
inventory scan and prepares the scanned file according to the collected data. The workstation then 
sends the file to the Primary Server for further processing. 

A.2  Inventory Workflow on a Primary Server
The Inventory Storer that is attached to the loader service wakes up every 30 seconds and checks the 
<Installed Path>ZENworks\work\collection\inventory folder. The Storer then picks up all 
the files in the <Installed Path>ZENworks\work\collection\inventory folder, which are 
saved as <timestamp>-<device guid>-delta.zip files. The Inventory Storer loads all the 
zipped files present in the folder, unzips the files, and sorts the files according to the time stamp per 
device. The unzipped files are stored in an XML format as<timestamp>-<device guid>-
delta.xml.

The Inventory Storer then begins processing each file by creating a WIF object out of the extracted 
XML files. After the processing is complete, the data is moved to the database as part of processing 
of the WIF XML for that device. After the WIF processing is complete, the XML file is moved to 
either a success or failure folder under <Installed 
Path>ZENworks\work\collection\inventory according to the errors caused by XML 
formats/database insert/update/delete issues that occurred during processing.

A.3  Troubleshooting the Inventory Workflow
If you are unable to view the devices in ZENworks Control Center: 

1 On the Primary Server, check the files in the <Installed 
Path>ZENworks\work\collection\inventory zipped folder to see if the loader is running.

2 If the loader is running, verify whether any PRU deploy or KBMerge process is also running as 
this stops the processing of WIF files untill the process completes.

3 If none of these are running, check the loader-messages.log to see if you find any log 
message stating that the PRU version is not in synchronization with the LMPRU version. 
Apply the PRU as the LMPRU to ensure that the PRU versions are not in synchronization.
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B
BTroubleshooting Asset Inventory

The following sections provide solutions to the problems you might encounter with Novell 
ZENworks 10 Asset Inventory: 

 “ZENworks Adaptive Agent on NetWare is unable to send inventory to the ZENworks Server 
or obtain settings from the ZENworks Server” on page 109

 “LDAP Import Tasks remain in a pending state if run simultaneously” on page 110

 “Inventory Only managed device is unable to post scans” on page 110

 “Inventory data of a managed device is not displayed for the Linux Primary Server” on 
page 110

 “How do I enable debug logging?” on page 110

 “Unable to import the inventory data gathered with the Portable Collector in ZENworks 
Control Center” on page 111

 “Inventory data of a device reregistered from one Management Zone to another is not 
displayed” on page 111

 “Event-based and On Refresh schedules fail for the inventory scan and collection data form” on 
page 111

 “Inventory reports list duplicate components during an inventory scan in ZENworks Control 
Center” on page 111

 “Unable to inventory the BIOS details for the Windows 7 64-bit devices that have SMBIOS 2.0 
or earlier installed” on page 111

ZENworks Adaptive Agent on NetWare is unable to send inventory to the ZENworks 
Server or obtain settings from the ZENworks Server

Source: ZENworks 10 Asset Management; Asset Inventory.

Possible Cause 1: The IP address of the ZENworks server is incorrect.

Action 1: Configure the correct IP address: 

1 In the sys:\ZENworks\zaa\uiaconfig.xml file, specify the correct IP 
address in the following line:

<server>ipaddress:80</server>

where ipaddress is the address of the server.

2 (Optional) To immediately post the scan, restart the zenaa module.

Possible Cause 2: The network connection or the ZENworks server is down.

Action 2: Ensure that the ZENworks server is up and running. 

Possible Cause 3: The primary server has been configured to run on a port other than 80. 

Action 3: Configure the correct port number: 

1 In the sys:\ZENworks\zaa\uiaconfig.xmlfile, specify the correct 
port number in the following line:

<server>ipaddress:80</server>
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where ipaddress is the address of the server.

2 (Optional) To immediately post the scan, restart the zenaa module.

LDAP Import Tasks remain in a pending state if run simultaneously

Source: ZENworks 10 Asset Management; Asset Inventory.

Explanation: If an LDAP import task has not finished and you simultaneously run a new 
task, the new task is not started and remains in a pending state.

Possible Cause 1: Multiple tasks are running simultaneously. 

Action 1: Before running a new task, ensure that all the existing tasks are in a finished 
state. 

Possible Cause 2: Multiple tasks have been configured to run on the same schedule. 

Action 2: Ensure that you do not set the same or simultaneous schedule for multiple 
tasks.

Inventory Only managed device is unable to post scans

Source: ZENworks 10 Asset Management; Asset Inventory.

Possible Cause: The uiaconfig.xml file might be corrupted.

Action: Do the following:

1 In the uiaconfig.xml file, add or change the IP address in the following 
line:

Server="a.b.c.d"

where a.b.c.d is the server IP address.

On Linux, uiaconfig.xml is located in opt/novell/zenworks/umia. 

2 (Optional) To immediately post the scan, restart the zenumia service.

Inventory data of a managed device is not displayed for the Linux Primary Server

Source: ZENworks 10 Asset Management; Asset Inventory.

Explanation: The inventory data of managed devices is not displayed for the Linux Primary 
Server in ZENworks Control Center. 

Action: Install the inventory-only agent on the Linux Primary Server. The Linux 
Primary Server is listed as an unmanaged device in ZCC (Device > 
Inventoried).

For information on how to install the inventory-only agent, see “Installing on 
Linux/UNIX” in the ZENworks 1 Discovery, Deployment, and Retirement 
Reference. 

How do I enable debug logging?

Source: ZENworks 10 Asset Management; Asset Inventory.

Action: To enable the logs, see TID 3418069 in the Novell Support Knowledgebase 
(http://support.novell.com/search/kb_index.jsp).
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Unable to import the inventory data gathered with the Portable Collector in 
ZENworks Control Center

Source: ZENworks 10 Asset Management; Asset Inventory.

Possible Cause: In the inventory scan file, special characters such as &, #, or 1 are appended 
with the <DateInstalled> tag. For example:

<DateInstalled>&#1;</DateInstalled>

Action: Do the following:

1 In the .xml file from which you want to import the inventory data, 
remove all the special characters such as &, #, or 1 that were appended 
with the <DateInstalled> tag and ensure that the tag contains the 
following information only:

<DateInstalled></DateInstalled>

2 Import the inventory data again. 

For more information on how to import the data, see Section 3.6.4, 
“Importing Data Gathered with the Portable Collector,” on page 44. 

Inventory data of a device reregistered from one Management Zone to another is not 
displayed 

Source: ZENworks 10 Asset Management; Asset Inventory.

Explanation: If a device is reregistered from one Management Zone to another, the 
inventory data is not displayed for the device in ZENworks Control Center. 

Action: Initiate an inventory scan twice on the device. 

Event-based and On Refresh schedules fail for the inventory scan and collection 
data form

Source: ZENworks 10 Asset Management; Asset Inventory.

Explanation: If an administrator configures an event-based or On Refresh schedule for an 
inventory scan and collection data form, the inventory agent fails to invoke the 
inventory scan and collection data form. 

Action: Configure only a Recurring schedule for the inventory scan and collection data 
form.

Inventory reports list duplicate components during an inventory scan in ZENworks 
Control Center

Source: ZENworks 10 Asset Management; Asset Inventory.

Action: To troubleshoot the issue, see TID 7003350 in the Novell Support 
Knowledgebase (http://support.novell.com/search/kb_index.jsp). 

Unable to inventory the BIOS details for the Windows 7 64-bit devices that have 
SMBIOS 2.0 or earlier installed 

Source: ZENworks 10 Asset Management; Asset Inventory.
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Explanation: If you want to inventory the BIOS details for the Windows 7 64-bit devices, 
you must have SMBIOS 2.1 or later installed on these devices. 

Action: None.
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C
CDocumentation Updates

This section contains information on documentation content changes that were made in this Asset 
Inventory Reference for Novell ZENworks 10 Asset Management. The information can help you to 
keep current on updates to the documentation.

The documentation for this product is provided on the Web in two formats: HTML and PDF. The 
HTML and PDF documentation are both kept up-to-date with the changes listed in this section.

If you need to know whether a copy of the PDF documentation that you are using is the most recent, 
the PDF document includes a publication date on the title page.

The documentation was updated on the following date:

 Section C.1, “November 17, 2011: Update to ZENworks 10 Asset Management SP3 (10.3.4),” 
on page 113

 Section C.2, “January 17, 2011: Update to ZENworks 10 Asset Management SP3 (10.3.2),” on 
page 113

 Section C.3, “March 30, 2010: Update to ZENworks 10 Asset Management SP3 (10.3),” on 
page 114

C.1  November 17, 2011: Update to ZENworks 10 
Asset Management SP3 (10.3.4)
Updates were made to the following section:

C.2  January 17, 2011: Update to ZENworks 10 
Asset Management SP3 (10.3.2)
Updates were made to the following section:

Location Update

“Overview” on page 11 Updated the section “Security Considerations” on page 11.

Appendix A, “Inventory Workflow,” 
on page 107

Added new section with the following updates:

 Section A.1, “Inventory Workflow on a Workstation,” on 
page 107

 Section A.2, “Inventory Workflow on a Primary Server,” on 
page 107

 Section A.3, “Troubleshooting the Inventory Workflow,” on 
page 107

Location Update

“Overview” on page 11 Updated the list of hardware components that appear in an inventory 
scan report. “Scanning for Hardware Information” on page 11
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C.3  March 30, 2010: Update to ZENworks 10 
Asset Management SP3 (10.3)
Updates were made to the following section:

Chapter 2, “Scanning Managed 
Devices,” on page 13

Reorganized content in chapter.

Chapter 4, “Scanning 
Demographic Data,” on page 45

Reorganized content in chapter.

Location Update

“Troubleshooting Asset Inventory” 
on page 109

Added the troubleshooting scenario “Unable to inventory the BIOS 
details for the Windows 7 64-bit devices that have SMBIOS 2.0 or 
earlier installed” on page 111. 

Location Update
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